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Introduction to branding 

Branding is a process which involves creating a specific name, logo, and an image of a particular 
product, service or company. This is done to attract customers. It is usually done through advertising 
with a consistent theme. 

Branding aims to establish a significant and differentiated presence in the market that attracts and 
retains loyal customers. A brand is a name, term, symbol, or other feature that distinguishes an 
organization or product from its rivals in the eyes of the customer. Brands are used 
in business, marketing, and advertising. 

Features of Branding 

Targetability 

Branding should be planned according to the targeted audience. No business firm can target the entire 
population. Business owners should identify the type of people who are buying their products and 
services. Research should be done on the basis of age, gender, income, the lifestyle of their customers, 
etc. 

Awareness 

The percentage of people who are aware of a brand is known as brand awareness. Well established 
companies have the benefit of a high level of brand awareness. Brand awareness can be increased with 
the help of advertisement on TV, radio, newspaper or social media marketing and advertising. Logos 
also help companies build brand awareness, as people often recognize brands by these symbols or 
diagrams. 

Loyalty 

Brand loyalty is the highest achievement or apex of any company. A customer who buys the product of 
a particular company extensively is known as a brand loyalist. Many consumers prefer using certain 
brands of clothing, deodorants or tubes of toothpaste, for example. They like how these brands benefit 
them. Brand loyalty can be built by staying in touch with the customers, asking them for their reviews. 

Consistency 

Consistency is necessary for a brand. A brand must remain consistent. Small businesses make 
numerous promises in commercials and ads about their brands, and consumers expect companies to 
continue living up to these promises. Their products should also be effective 
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LEARNING UNIT 1: IDENTIFY AND SELECT OF INTERIOR BRANDING DESIGN 
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STRUCTURE OF LEARNING UNIT        

Learning outcomes: 

1.1 Identify interior branding 
1.2 Describe interior branding principles. 
1.3 Select interior branding type. 
 

 

Learning outcome 1.1 Identify interior branding 

 

Duration: 10 hrs 

Learning outcome 1.1 objectives:   
By the end of the learning outcome, the trainees will be able to: 

1. identify types of interior branding 

2. Identify the materials of each type of branding 

3. describe the advantages and disadvantages of each type of interior branding 

 

Resources 

Equipment  Tools Materials  

▪ Books 
▪ Computers 
▪ projector 
▪ Board   
▪ Flip chart 

▪ Marker pen 
▪ Pen 
▪ Chalk 
▪ Flash drive 

 

▪ Internet 
▪ Banners 
▪ Papers 

 
 

Advance preparation: 

▪ Provide banners and other branding materials in class to show them to 
learners 
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Indicative content 1 Types of interior branding 

 

1.1 Digital Wallpaper 
 

     

As an industry leader in window film and associated products, we pride ourselves in utilizing the newest 

and most innovative products on the market. An increasingly popular product is digital wallpaper. 

This multipurpose product has a number of benefits, not least its unique surface which means it can be 

printed by the majority of printer types. We use both solvent and UV printing techniques to recreate 

patterns, images and designs in eye-catching quality.  

 

Digital wallpaper can be applied to a number of surfaces, providing a quick and efficient way of giving 

walls, doors and other traditionally uninspiring surfaces a new dimension. 
Digital printing has made wallcovering highly customizable and able to be produced on-demand to serve 
in customized situations. Often used for murals, digital printing is defined as one of several non-impact 
technologies where the image or pattern is created, manipulated and finalized by electronic systems 
and printed by a computer-controlled printer. 

Types of digitally printed wallcoverings include: Mylar, Paper and Vinyl. 

Digital printing on paper and Mylar is most commonly used in low-traffic areas, while vinyl wallcovering 
is typically used in high-traffic/public areas. 

Mylar wallpapers are often mistaken for foil wallpapers because they are very similar in nature. Mylar is 
actually a polyester film that is metallized sheeting. Mylar will not tear very easily, but will burn. Foils 
will tear easily, but will not burn.  

Benefits of digital printed wallpaper for businesses 

Wallpaper has long been relied on to add a bit of color, texture and personality to a space. Recent 

advances in technology and developments in printing have allowed for digital wallpapers to be 
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produced. Digital print wallpaper has the ability to bring empty spaces to life, among other benefits. 

Here’s what they can bring to businesses. 

1. It’s a real showstopper 

Many modern consumers, especially those with a penchant for interior design, don’t like to settle for 

things off the rack. They prefer something unique and personalized – a quality provided by digital 

wallpaper. 

Digital wallpaper allows for more scope for creativity because you can design a custom wall covering 

precisely to your taste. There are, of course, many wallpapers with striking prints you can choose from, 

but there’s only so many. And you’re not only limited by the range, but other people may have them so 

it won’t give your office or event space the truly unique aesthetic that you want. 

You don’t have to choose illustrations and graphics for your digital wallpaper either. Photo murals, also 

known as fotowalls, can be produced. Not only are they wildly popular in many modern businesses, 

from hotels to offices, but they are also extremely eye-catching and memorable. 

2. It can always look new – if you want it to 

Digital wallpaper is ideal for short runs and can be printed on demand. This means you can always have 

wallpaper in the most fashionable prints and innovative concepts that always looks new. 

This is because digital wallpaper manufacturers don’t have to sit on stock, so they can easily print 

wallpaper whenever you need it. As a result, even the most fashion-conscious businesses can change 

their wallpaper as often as they change their marketing campaigns. 

3. it’s so unique, it’s memorable 

Because digital wallpaper allows for such a huge scope in creativity, you can create images that are 

totally unique to your business. You can design anything from simple illustrations to animated graphics. 

Not only can these designs be showstoppers, but they can be so unique that they’re memorable. 

For example, imagine walking into a hotel and seeing a fotowall made up of stunning, high-resolution 

images. It can let you submerge into the hotel surroundings and help promote the relaxing feeling of 

escape that you crave when paying for a night in a hotel. 

This is the sort of effect digital wallpaper can have on your audience and something that you want to 

achieve on a regular basis. 

4. it can boost brand awareness 

Digital wallpaper can be so striking that it prompts you to take a photo of it and share it on social media 

or send it to your friends. This would help boost that company’s brand awareness. 

https://www.dominionprint.com/5-fantastic-benefits-of-digital-print-wallpaper-for-businesses/#Showstopper
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Now, let’s imagine that it’s your company with the striking digital wallpaper. Every time your attractive 

prints prompt someone to take a photo and share it, or even just ‘wow’ them so much that they tell 

other people about it, you’ll be boosting your own brand awareness. 

This is what’s great about customizable wallpaper – you can truly make it your own and make sure that 

your brand is what stands out, not just the design. 

5. it’s more durable and longer lasting 

Whether you’re using paint or traditional wallpaper, there’s always the risk of chips, marks and stains 

which will then require fixing. As well as this, sheens, glosses and intensity of colours can quickly fade – 

meaning that you’ll need to touch up at regular intervals to keep your walls looking fresh. Not only is 

this time consuming, but it can also ramp up the costs in the long run. 

In contrast, digital wallpapers are much more durable, being able to fully resist wear and tear in ways 

that paint simply can’t. For example, digital wallpapers are tear-resistant and stay looking fresher for 

longer than traditional papers and paint. This means that you don’t need to top it up or replace it as 

often, so it saves time and is more cost effective in the long run. 

When you’re designing a space, wallpaper will be one of the first and main things you’ll consider 

because what goes on the wall can tie everything in your room together. And not only can it make or 

break your interior design, but it can also help you create the big impact you need.  

1.2 Wall panel branding 

  

 

A wall panel is single piece of material, usually flat and cut into a rectangular shape, that serves as 

the visible and exposed covering for a wall. 

Wall panels branding is a great way to add colour, texture and depth into an interior space and give it an 

extraordinary transformation. These wall panels can be made of various materials like MDF, glass, vinyl, 

fabric, PVC and so on. Besides, a well-designed wall panel can also become the focal accent in the 

interior room and light it up like never before.  

https://evolveindia.co/ready-to-install-wall-panels/
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Thin wall panels are a popular choice for creating intricate designs like ribbed paneling or even framing 

artwork. Alternatively, wood panels are being opted instead of tiles in bathrooms, to create open 

shelving or replace bedroom headboards. Clearly, wall paneling design is pretty limitless and it’s no 

surprise it is making such a huge comeback, however, this isn’t the only reason 

Not only is wall paneling on trend, but it is also a simple and affordable addition that can help create 

added value to a home. The use of naturally sourced timber also makes for a more sustainable 

approach to making home improvements, a trend that is more important than ever. 

Wall panel branding is one of the most widely used and accepted ways to stylize and add 
character, texture, or even hide errors in a wall in interior design. 

Wall paneling is an economical way to mimic art and finery that would have been challenging to 
recreate in everyday households. 

While panels made from wood or engineered wood are likely more durable and permanent, and 
3D cut panels are also popular today. 

The most crucial factor of wall paneling is that they allow you to customize the colors and sizes 
to fit your area perfectly.  

Different Types of Wall Panelling 

1. Wooden Paneling 

Sheets of solid, engineered wood and other wood-like products are cut and made into large 

panels. These wooden panels can be made in different styles, from carvings and fenestrations 

to complex 3D designs. They are more resilient and will last a lifetime, just like traditional 

wooden furniture. 

2. Wainscoting or beadboard paneling 

 

Made from wood or other synthetic materials, this 
paneling style is carved into patterns similar to the 

woodwork found in wall trimmings and crown moldings. 

Wainscot paneling is mainly reserved for the bottom 
half of the wall and requires a healthy amount of skill 
and precision to install. 

 

https://foyr.com/learn/how-to-use-textures-in-interior-design/
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3. Veneer and laminate paneling 

 

 

As the name suggests, they are made from particleboard or 

wood veneer. Veneer panels, though expensive, look highly 
sophisticated when finished with a coat of polish. These 

panels are commonly found in more formal settings of high-
end dens, offices, and clinics.  

 

 

4. MDF paneling 

MDF is produced by compressing wood shavings at a very high 

temperature. This style of paneling lends stability at affordable prices. 

MDF panels are ideal for 3D designs and carving. Finally, you can also 
paint them in a color of your choice since MDF doesn’t absorb the paint, 
unlike wood. 

 

 

 

5. Fabric paneling 

Fabric paneling is widely used in bedrooms and entertainment 

rooms because it is excellent for sound-proofing. Starting with a 

wooden base, they are padded with a foam layer and covered 
in fabric. 

 

 

6. Metal paneling 

Aluminum, Corten steel, and copper are popular types of metal 

wall panels. These panels are not only durable but also add a 
modern and sleek twist to your walls. An added perk to metal 

panels is that they can form a beautiful patina over time. While 

this style is not everyone’s cup of tea, it is a contemporary 
model 
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7. Chipboard paneling 

Chipboard is made by pressing together sawdust 

with wood chips. It does not share the same 

strength as wood and can only be used in dry 

areas. If there is contact with water at any point, it 
will start to swell and disintegrate. 

 

 

8. PVC paneling 

A classic utilitarian style, PVC panels, are used mainly for 

their water resistance and robust properties. It consists of 
small amounts of plasticizer and polyvinyl chloride. 

 

 

 

 

 

Benefits of wall panels branding 

1. Easy to Install 

The installation component is one of the biggest reasons people postpone home improvement 

projects. A home redesign tends to be tedious and time-consuming. Additionally, the expense can 

also be a pain point if you’re hiring a professional to do it. 

Fortunately, wall panelling doesn’t fit in this category. Because of the ease of installation, wall 

panelling is an excellent do-it-yourself project for those who consider themselves handy or willing to 

put in the work and learn. Tongue-and-groove designs and clipping systems make installation easier. 

All you need are the correct dimensions, the right supplies, suitable tools, and a little free time to 

mount the panels to your walls. 

2. Plenty of Material Choices 

While traditional wall panelling is wooden, this material is not your only option! Modern 

materials such as medium-density fibreboard and melamine are more durable and impact-resistant, 

making them suitable for high-traffic areas when scuffing and denting are likely to occur. Melamine is 

moisture-resistant, allowing for installation in kitchens and bathrooms  

Are you looking to try paneling in only one room in your home? A single wall, covered on the top half 

with peel and stick wallpaper and then complimented on the bottom with beautifully painted accent 

https://www.themouldingcompany.com/blog/ideas-for-replacing-or-updating-wood-paneling/
https://www.themouldingcompany.com/blog/ideas-for-replacing-or-updating-wood-paneling/
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wall panels, can add enormous dimension to any room. It elevates the look from plain to stunning 

without the intense time, effort, or expense a remodel would take. Alternatively, add the same 

wallpaper and paneling around the entire room for an enormous wow factor and an incredible 

upgrade for the space! 

 

3. Wall Panelling Offers Protection for Your Walls 

Panelling isn’t just decorative. It also serves a functional purpose by protecting your walls from 

damage! Homeowners often choose baseboards, chair rails, or wall panelling to protect against 

everyday dings and dents that eventually appear on everyone’s walls. 

You can choose to purchase impact-resistant panelling, which is less likely to be dented, scratched, or 

otherwise banged up for even more protection. Even when your wall panelling starts showing signs of 

wear and tear, cleaning or replacing a section of panelling is easier than repairing drywall. 

4. Flexible Design Choices 

There are numerous ways to cover your walls with panelling. Throughout history, the type of wall 

panelling in residential and commercial buildings has changed to reflect society’s tastes and trends. 

You can even create a profile of 3D wall panels. 

Want something more colourful than the white common in modern design or the natural colours of 

wood used in historical applications? You can paint or stain panelling any way you want to suit your 

design tastes  

Wall panelling, when used cleverly, can also be used to hide away unsightly or tangled cords. That’s 

why so many people use accent wall panels! You can even install it over rough or uneven surfaces to 

give the space a more even finish.  
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5. Low Maintenance 

As mentioned previously, wall panelling is much simpler to replace or repair than drywall, but it is 

also very low-maintenance. Of course, it depends on the material you choose for your panelling, but a 

microfiber cloth, some water, and a gentle cleanser are often all you need to wipe panels down and 

keep them looking their best. 

6. Soundproofing and Insulation 

If you are looking for a simple way to add more soundproofing and insulation to your home, wall 

panelling can also help. Adding this layer to your walls can help keep warm air in during the winter 

and cool air in during the summer. It also acts as an additional buffer to sounds from outside your 

home or between rooms so that you can enjoy a quieter environment. 

1.3 Branding signage 

What is signage and what is its purpose? 
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A signage is a visual graphic that displays information to nearby people. It can be in words, numbers, 

images, or a combination of all three. 

You see signage everywhere, from the stop sign at a busy intersection to the “Exit” sign above a 

doorway. It can also be an advertisement for a product or service, a wayfinding guide to help people 

navigate a space, or a warning or instruction. 

In short, signage is one of the most important forms of communication. And like all forms of 

communication, its effectiveness depends on how well it is designed. Hence, signage design is a field of 

study all on its own. 

What is the purpose of signage? 
Typically, signage tends to serve a few common purposes: to promote, identify, provide information, 
give directions or to raise safety awareness. Allow us to expand: 

1. Advertising & Marketing 

Firstly, signs are often used for advertising and marketing by companies or organisations. 
While advertising hoardings may initially present themselves as the obvious solution for companies, 
there are other signs that can be used for this purpose. Other outdoor signage solutions and building 
wraps are an alternative and successful way to advertise a brand. Wide format printing has progressed 
to a point where large vivid outdoor prints can be put almost anywhere! 

 

2. Entice Customers 

Relatedly, retail signs & shop signs (both inside and out) can attract business to a company. Also, to 
entice customers from the outside, window displays can be successful at creating curiosity and 
encouraging customers to venture inside. Business signs let people know they’re in the right place. 
More importantly, if the sign maker has put quality of production centre in their thinking, business 
signage can create a great first impression of your business before a single door has been opened or 
greeting made. 

 

https://octink.com/hoardings/advertising-hoardings/
https://octink.com/signage/outdoor-signage/
https://octink.com/display-graphics/building-wraps/
https://octink.com/display-graphics/building-wraps/
https://octink.com/display-graphics/window-displays/
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3. Recognition  

Quite simply, signs are often designed to help individuals recognise or identify a place or brand. For 
instance, signs help us to identify which restroom to use. In terms of brand identity, Coca-Cola and 
Starbucks have become instantly over the years, and recognisable high street signs as part of their 
marketing strategy. Chains and franchises will use similar shop fronts to build brand recognition 
throughout their locations. 

 

 

4. Wayfinding & Directional Signs 

Directional signs are necessary for vast locations such as shopping malls, hospitals and corporations. 
With these building signs, visitors or customers are less likely to get lost which helps to avoid a situation 
that could reflect badly on the business. Directional signage can also be useful for large scale outdoor 
events such as festivals or places where there are multiple buildings or entrances. 
 

 

5. Health & Safety Signs 

Health and safety signs are one of the main means of communicating health and safety information. 
They can be found in places such as workplaces, nurseries, schools and offices. Signs provide 
information and warnings about hazards or threats which are essential to safety. 
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6. Appearance 

Finally, not all signage necessarily serves an overt purpose! Sometimes a sign may be used simply to 
enhance the overall appearance of a space or its surroundings. We’ve even created signage using wall 
murals – with no objectives of advertising. 

 

1.4 Large format printing 

What is large Format Printing? 

large format printing is, essentially, the printing of large graphics or designs onto large rolls of paper (or 

other materials). It requires the use of specialist equipment, and much larger printers than standard 

commercial units. In general, ‘large format printers’ are to considered to be those with a max width of 

18-100 inches. 
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What is large format printing used for? 

In general, wide format printing is used to produce large graphics for marketing, branding, and 

advertising purposes. These can take many forms, but things such as construction site hoarding 

graphics, fleet and vehicle vinyl wraps, and printed retail graphics and displays tend to be some of the 

most common uses for the format. 

For the most part, these kinds of adverts – particularly those that fall into the category of ‘outdoor 

advertising’ are intended to be displayed in front of a large number of people, and will be viewed from a 

distance. For this reason, large graphics are required, and it would be somewhat impractical to ‘stitch’ 

together a large number of small graphics. 
Why should brands use large format printing? 

Put simply, brands should make use of large format printing because it offers one of the most effective 

ways to market a product or service, through outdoor advertising and other forms of OOH (out of 

home) marketing in key areas of pedestrian and vehicle traffic. 

The active benefits of the different types of large format printing will depend on the products 

themselves, but on the whole, outdoor advertising remains one of the most bountiful forms of 

marketing.  

Materials that can be used for large format printing 

 

 
When it comes to the actual production of large format graphics, there are all kinds of exciting materials 

that can act as substrates. These range from paper, to vinyl, and even things like metal or fabrics. These 

different materials can serve a wide variety of different purposes, and provide a range of aesthetic and 

practical benefits. 

Usually, substrates are selected for their particular suitability to the needs of a specific project. Retail 

graphics, for instance, might utilise a slightly less durable (and therefore more affordable) vinyl than 

outdoor hoarding graphics or vehicle graphics. Similarly, graphics that are intended to be placed in city 

centres might use an ‘anti-graffiti’ vinyl to deter would-be vandals from ruining the visual impact of the 

structures. 
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Substrates broadly fall into two categories – those that are rigid, and need to be fed into a printer flat 

(such as a metal sheet) and those that are fed on a roll (such as vinyl). Not all suppliers will be able to 

offer all substrates, but a few of the most common examples include: 

Paper 

Paper is so adaptable and widely available that it’s little surprise it remains one of the most popular 

large format printing substrates. With that said, while it may be cheap and easy to get hold of, it isn’t 

exactly the most durable material, and for outdoor or long-term installations, it isn’t the go-to choice. 

Vinyl 

For outdoor and long-term installations, vinyl is the go-to choice. Vinyl is extremely flexible, easy to cut 

and shape, and comes in a wide variety of different finishes, from matte to gloss and even reflective 

mirror vinyl. This is the material used on many outdoor advertising products (as well as things such as 

vehicle wraps) due to its affordability and versatility, and is often adhered to a rigid background for 

support and added durability. 

Fabrics and textiles 

With the arrival of new large format installations such as tension fabric frames, it’s not surprising to see 

an increasing number of wide format print suppliers offering prints on fabric. These substrates can serve 

a wide variety of purposes, from simple frames to acoustic treatment panels. 

Wood, metal and other rigid substrates 

Wide format print suppliers with specialist equipment are able to print on solid and rigid materials such 

as aluminium or wood, and while this may not be anywhere near as common as something like vinyl, it 

means large format printing can be used for all kinds of unusual projects, such as art or photography 

exhibitions. 

 
Benefits of large format printing for your Business 

Large Format Printing Increases Brand Recognition and Visibility 

By employing large format printing technology, your business can produce sustainable, clear, sharp 

content and images that are easily visible from a distance. The information about discounts and deals 

on material printed in a large format will catch the eye of prospective clients in your target area and 

brand your business. Large-format printing also entices potential clients at exhibitions or trade shows 

by providing a clever call-to-action in the display that will generate leads for your business.  

Large format printing is commonly used to drive attention to billboards, banners and posters. If you’re 

looking to draw attention to an event or a business, wide format printing is likely what you need to 

create high impact advertising.  Large scale printing is going to be eye-catching which means you will get 

greater ROI from customers down the street or across a crowded trade show room! Because your 

branding message will be clearly legible from a distance, you don’t have to worry about not seeing a 

return on investment. You will capture consumer attention which translates into increased sales and, 

potentially, greater brand loyalty. 
Large Format Printing Uses Long-Lasting Low-Cost Materials 

https://gonextpage.com/studio-portal-case-studies-lp/
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Some large-format printing projects are designed to be mounted outside. For example, posters and 

billboards are placed outside for long periods of time so they must be able to maintain the quality of 

your brand. Large format printing is capable of withstanding constant exposure to diverse weather 

elements since they are made from UV-resistant and durable materials. Billboards and transit graphics 

must be able to withstand the elements and last through all kinds of weather while still being adaptable 

and durable. If you need to print something that can stand up to the elements, large format printing is 

the way to go.  

There are multiple benefits to using large format printing for your projects. You will have the advantage 

of a large area to display your printed project as well as the benefits of UV-cured ink that makes the 

printed material able to withstand rain, heat, and sunlight without any damages. Another benefit of 

large format printing is the ability to print on a variety of substrates, through the carrier of the printer, 

including: 

• Vinyl 

• Cloth 

• Glass 

• Wood 

• Foam Board 

• Corrugated Plastic 

• Metal 

No matter your current graphics needs, large format printing provides durability as well as a large 

display area that allows your message and products to be both eye-catching and visible to the public.  

 
 

Floor Graphics 
Floor graphics are specialty decals created for floor advertising using special adhesives and durable 
laminates designed to be stepped on. 

The most efficient floor graphics are placed in areas of high foot traffic in permanent or temporary 
consumer-friendly spaces.  As with all quality signage, floor graphics printing is highly customizable 
depending on design, application surface, and desired lifespan. 

The many uses of floor graphics 
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Despite their constant grounded position, floor graphics are a versatile aspect of indoor and outdoor 
signage. These custom floor decals can: 

• Direct foot traffic: Stores and other retail spaces can utilize floor graphics to guide consumers to 
optimum routes through the selling areas. These routes help highlight on-sale or premium 
product stock. 

• Catch the attention of potential buyers: No matter age or gender, most people tend to watch 
where they’re going. Floor graphics take advantage of this directional sense to optimize every 
second of consumer time. 

• Fight the draw of the smartphone: When customers use smartphones, their gaze often drifts 
downward. While this posture can cause them to miss signage at eye level, floor graphics will 
still be easily visible. 

• Promote branding during a convention or trade show: Floor graphics are easily applied and 
removed, making them perfect decals for temporary events like conventions or trade shows. 
These areas typically see high foot traffic from people unfamiliar with the venue; effective floor 
graphics printing can not only grab attention but guide potential clients to the booth. 

• Optimize retail space: Larger warehouse-style stores and events can have difficulty convincing 
attendees to walk all distances. This challenge usually reflects in areas with shifting success rates 
– high amounts of sales near the front of the store and lower amounts near the back. The 
outskirts are less attended and, as a result, less successful. Floor graphics can motivate 
consumers with periodic directions and incentives to keep walking. 

• Provide important safety information: Certain larger events can become crowded, increasing the 
likelihood of incidents. Floor graphics can help define walking lanes for parents with small 
children and the elderly, helping to keep them safe. 

• Highlight branding at a sports arena or other broadcasting venue: Professional sports remain a 
huge draw for many people. Floor graphics are an effective and seamless way to show off a logo 
and promote branding during a game. 

• Welcome guests: In many ways, the welcome mat was one of the original floor graphics. While 
these specialized decals have become more sophisticated and cost-effective, bidding a polite 
“hello” has never gone out of style. 

• Customize celebrations: Weddings, proms, and other significant personal events can all benefit 
from a custom-printed floor display. 

• Point of Purchase: Designing floor graphics for point of purchase areas in retail stores can be a 
great way to direct the flow of traffic.   

Why floor graphic quality matters 

Floor graphics are among the most durable form of graphics available – they have to be. Considering 

that effective floor decals are in areas with high foot traffic and cleaning machines, the material must be 

built to withstand a constant barrage of shoes, bags, and other wear. Printers of floor graphics also 

need to construct them with specially formulated adhesives to remain anchored to a variety of flooring 

types, yet easy to remove when the promotion is over 

Types of floor graphic materials 

Floor graphic vinyl 

The intended purpose of the floor sticker will dictate which vinyl works best for your graphics. You need 

to consider whether it’s temporary or permanent, whether it’s being applied to a rough or smooth 
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surface and whether it will be placed indoors or outdoors. The top media manufacturers produce vinyl 

specifically designed for floor applications. 

Laminate 

If you want to give your designs extra protection and secure business in areas that are subject to tight 

legislation, it’s a must-have. These custom-designed laminate materials have a non-slip textured surface 

to improve grip. Again, the purpose will determine the best laminate for the job but make sure it has 

some non-slip certification. For short-term applications, it's also possible print directly onto textured, 

non-slip vinyl. 

Ink 

Eco-solvent, UV and latex ink can all be used for floor graphics. In most cases the protection of the 

laminate means that ink durability isn’t a vital factor, but if your print will be exposed to the elements 

and constant footfall, the ink will need to be tough enough to last.  

Designing floor graphics 

Although some floor graphics are designed to be viewed from above, for most applications, the 

intended viewer will be on the same floor as the graphic. People tend to view the floor from a different 

angle than they would a wall and this is an important consideration. There are two cases you need to 

design for. 

Viewer in motion: These graphics are designed for open spaces, corridors, aisles and other areas of 

transit. As they will be seen from a slight distance, the graphic will need to be elongated to compensate 

for the unusual viewing angle. 

Viewer at rest: These graphics are often used as place markers, from a design perspective, a pair-of-

shoes motif is a great way to put the viewer right where you want them. 

 

Commercial opportunity: Because the design is crucial in an effective floor graphic, big brands will have 
teams of professionals working out the correct perspective and ideal placement. If this is within your 
design capabilities, make sure to offer it as a service and charge accordingly. 

Installing floor graphics 

• Print the graphic on the appropriate vinyl, laminate and weed off any excess. 
• Like any installation in a public space, observe the usual health and safety procedures and 

conduct the appropriate risk assessments before you begin. 
• Remove any dirt, dust and grease from the entire area and dry it thoroughly to ensure that your 

floor sticker can adhere firmly. 
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• Look out for cracks, bumps and inconsistencies in the surface. Large cracks will stop the vinyl 
adhering evenly resulting in peeling and warping (and dissatisfied customers). Premium floor 
vinyl are available with extra layers of adhesive perfect for wonky floors. 

• Using a squeegee, carefully apply the vinyl from one end avoiding any kinks or bubbles. Take 
particular care on uneven surfaces and adjust your technique to compensate for steps and 
ridges between tiles or floorboards. 

• Inspection the work done to ensure that your vinyl securely adheres, particularly around the 
edges.  

Benefits of Floor Graphics 
1. Attention grabbing 

Floor graphics aren’t something that a customer comes across every day. Unlike window displays and 

light boxes, they’re a little more unique and eye-catching so they immediately grab the attention of 

whoever’s walking on them. 

Decals and graphics on the floor often catch people off guard, especially if they’re somewhere that you 

wouldn’t expect, like an escalator or on the stairs. Because you’re more likely to grab someone’s 

attention, you have a better chance of connecting with them which, in turn, means they take notice of 

your product or message. 

2. Directional 

Firstly, floor graphics can have a purely practical purpose. They can be used to direct customers or 

visitors to the right place. If you have different departments within your store, then floor graphics can 

be followed by customers to the section they’re looking for. 

This removes confusion, allows you to create an easy-to-understand store pathway and helps customers 

to find the products they want in a much quicker time. If they can’t find what they need, then they’re 

more likely to get frustrated and go elsewhere. 

Secondly, floor graphics can be used in a directional sense to essentially grab customers from elsewhere 

and bring them to you. 

Footsteps are always a popular choice because they’re easy to follow and can contain intriguing offers 

to entice someone. Write a tempting offer and have footsteps lead from it to your store and you’ll see 

an increase in the number of customers through your door. 

3. Creative and unique 

Retail floor graphics are an opportunity to be creative. You can use them to make an excellent first 

impression and stand out from your competitors. The very best designs are an attraction all by 

themselves and businesses can take advantage of free advertising as customers take photos and share 

them on social media. 

Keep in mind that what might work as a sign on a wall or window display might not be as effective on 

the floor. Don’t have the floor graphics contain a lot of text that’s inconvenient to read. The last thing 

you want is customers getting frustrated with each other because they’re covering information by 

standing on it. 

4. Saves Space 
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One of the biggest selling points of Floor Graphics is the amount of space you save in using them. 

Whereas with advertisements stands and large-scale posters you need to allocate a particular amount 

of room, Floor Graphics don’t have that problem for obvious reasons. 

Due to their lack of restrictions compared to other forms of advertising, Floor Graphics, namely Retail 

Floor Graphics, tend to be used more occasionally now as a quick way of advertising without having to 

take up loads of room to do so. With Viny line, rest assured that our various types of Floor Graphics will 

allow you to advertise and catch people’s attention without causing any form of obstruction. 

 

Theoretical learning Activity  

• Make a group of four persons and discuss the types of interior branding   

Points to Remember (Take home message) 

 

• Types of interior branding 
 

 

Learning outcome 1.1: formative assessment 

Written assessment 

1.The following table is composed by types of interior branding and their meaning match column A and 

column B accordingly.     

No Column A  Column B 

 
1 

1. Is the digitally printed wallpaper used to create large 
one-of-a-kind murals. 

a. Floor graphics branding 

 
2 

2.l is single piece of material, usually flat and cut into a 
rectangular shape, that serves as the visible and exposed 
covering for a wall. 

b. large format printing 

 
3 

3.is the design or use of signs and symbols to 
communicate a message to a specific group, usually for 
the purpose of marketing or a kind of advocacy 

c. Ceiling brand  

 
4 

4. is the big printed format of banners used indoor 
branding that can be used to cover the whole interior 
room or walls.  Large format printing can help your 
company increase brand awareness, promote new 
products or services, promote a special event and reach 
new customers 

d. Wall panels 

 
5 

5. consist of branding on the floor either using branding 
stickers or painting graphic design branding. Floor 
graphics offer an effective branding solution for both 

e. Digital wallpaper 

https://www.www.vinyline.co.uk/
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internal and external use. Suitable for events, 
exhibitions, marketing or commercial installations 

6  f. Signage 

Answer:  

1. e 

2. d 

3. f 

4. b 

5. a 

Learning outcome 1.2 Describe interior branding principles 

Duration: 5 hrs 

Learning outcome 1.2 objectives:   
By the end of the learning outcome, the trainees will be able to: 

1. describe the interior branding principles 

2. use interior branding principles 

 

Resources 

Equipment  Tools Materials  

▪ Books 
▪ Computers 
▪ projector 
▪ Board   
▪  Flip chart 

▪ Marker pen 
 

 

 

▪ Internet 

• Banners 
 

Advance preparation: 

• Provide tutorials in class rooms to help you describing different types of 
interior branding principles 
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Indicative content 1 Introduction to interior branding principles 

 

 
When it comes to interior design, there are certain principles and elements that every professional 
needs to be aware of to create a cohesive and stylish space. By understanding these key concepts, they 
will be able to put together a functional and visually appealing room. 
What are the principles of interior design? 

The principles of interior design are the rules and guidelines that designers follow to create functional, 

aesthetically pleasing spaces. There are seven main principles of interior design: Repetition or rhythm, 

Balance, unity and harmony, proportion and scale, emphasis, contrast, and details. These concepts can 

be applied to any room in your home, from the living room to the bathroom. 

Rhythm or Repetition  
The human brain is drawn to repetition and recognizes similar objects quickly. Thus, rhythm, which is 
about creating repetition and contrast in an interior, helps carry visual interest around the room. 

There are many ways to create rhythm, such as using the same color or pattern at different intervals. 
For example, you can paint a wall green, and then use the same color again on the dining chair 
cushions. This is called repetition rhythm. You can also use alternation to create rhythm by rotating two 
elements in an ABABAB or ABBABB pattern, such as alternating 2 types of pendant lights. If you are 
feeling more adventurous, you can try progression rhythm, which arranges elements in ascending or 
descending order based on their size, colour or other characteristics. 

Repeating elements such as colour, shape or texture can help to unify a space and create a consistent 

visual experience. Mismatching carpets, different colour schemes or pick ’n’ mix windows all create 

confusion in a space. 
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Balance 
The definition of balance is ‘the even distribution of weight leading to steadiness or evenness’. A 

balanced design does exactly that; it creates equality and symmetry that the eye loves. But as with most 

of these principles, if applied too rigidly it can become boring. Enhance your balance with other aspects 

of design to make it a little less formal. 

 

To do this at home, find the focal point of your space, which could be a TV, a fireplace or a large piece of 

art. Then evenly arrange objects on either side. Make sure these are either identical or of equal visual 

‘weight’ (weight depends on size, colour and texture, eg black has more weight than grey). You could 

also try asymmetrical balance – rather than mirroring items, play around with a slightly off-balance 

combination of weights, colours and textures. Have a go and see how you get on. 
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Harmony and unity 
This principle is used to put a person at ease within their environment and create unity, thereby 

eliminating any feelings of disquiet. Harmony, in a sense, provides the ‘full stop’ to any interior design – 

when harmony is in effect, the space should feel complete because all its parts relate to, and 

complement, each other. This feeling is the result of balance, scale, proportion and repetition all being 

used in the right amounts.  

 

 Unity 
The unity principle emphasises a sense of uniformity or harmony among the elements used in design. 
These include having similar colours, patterns or textures, equal spacing of objects or repetition of 
elements to create a visual continuation. 

To put it simply, when elements are carefully curated, you feel that they come together nicely. For 
example, if you have a variety of shapes and textures in a space, you can still create unity by using just 
one colour scheme. 
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Emphasis 
In interior design, emphasis is the use of an accent in the room, such as color, component, texture, or 
pattern, that draws attention. A room with no focal point is forgettable and dull. The principle of 
emphasis, then, calls for choosing one item in the room to serve as the center of attention, around 
which the rest of the decor will revolve. Radial balance works with this principle and helps draw 
attention to the chosen point of emphasis in the room. 

The focal point can be an existing feature you want to highlight, such as a fireplace, a piece of furniture, 
or art that you want to use as the starting point for your design. Once you have decided on your focal 
point, the rest of the room should be designed to complement it. Color is one of the most powerful 
tools that you can use to create emphasis. A bold color will immediately draw the eye, so if you want to 
highlight a particular area, painting it in an intense color is an effective way to do this. A pattern can also 
create emphasis; a bold pattern will make a strong statement, while a more subtle one will add interest 
without being overwhelming. 

Texture is another tool that can be used to create emphasis. A rough texture will stand out more than a 
smooth one. So, if you want to highlight a particular area, using a textured finish such as stucco or brick 
can be an effective way to do so. 

The principle of emphasis can be used in both small and large spaces. In a small room, it is often 
necessary to have a focal point to make the area feel more cohesive and unified. In a larger room, you 
may have more freedom to play with different elements and create multiple points of interest. 
However, too many focal points can be distracting and make the space feel cluttered. When using the 
principle of emphasis, it is essential to strike a balance between creating a space that is interesting and 
one that is harmonious. 

 

https://www.interludehome.com/
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Contrast 
There are many ways to create contrast in a room. One of the most obvious is using color. Pairing light 
and dark or warm and cool colors can create a striking effect. You can also use contrast in terms of 
texture, pattern, and scale. 

When using contrast in your design, it is important to remember that less is usually more. Too much 
contrast can be overwhelming and make a space feel chaotic. It is essential to find the right balance to 
create a pleasing and harmonious space.  

Contrast provides visual interest and helps to define spaces. Done well, it can make a room feel dynamic 
and exciting. 

 

Proportion and Scale 
The concept of proportion and scale is the ideal approach to generate a sense of belonging among 
objects in a room. Things must be in balance with each other and the space, whether it’s size, shape, 
form, or color. The importance of this principle is understanding how to use the surrounding area, 
whether it be a large or small room. 

Proportion is the relationship between two items, and scale is the way that one object’s size relates to 
another. For example, a huge, overstuffed sectional in a tiny space will be out of proportion. A small 
coffee table in front of two enormous sofas might appear misplaced and lost.  

Creating visual interest in a room can be as easy as playing with scale. Scale refers to the relationship 
between the size of objects and the size of a space. To add excitement without going overboard, try 
combining ordinary items with pieces of different heights and dimensions, such as art or greenery.  
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 Details 
A room can never feel put-together and personal unless it contains the right finishing touches. And the 
good news is that you don’t need to be a professional interior designer to add them! This final step 
allows you to show off your unique style and personalize the space with things that interest you. 

Details make a room unique. By adding personal touches and paying attention to small details, you can 
create a space that is truly your own. 

 

Theoretical learning Activity  

• Brainstorm the different principles of design and differentiate them 

Points to Remember (Take home message) 

 
 
 
 
 

Differentiate the following interior branding principles: 

a) Balance 

b) Harmony and unity 

c) Scale and proportion 

d) Repetition 

https://www.globalviews.com/
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Learning outcome 1.2: formative assessment 
 

Written assessment 

1.Describe the characteristics of the following interior design principles 

a) Balance 
b) Repetition 
c) Rhythm 
d) Harmony 
e) Unit 
f) contrast 

Learning outcome 1.3 select interior branding 

Duration: 5 hrs 

Learning outcome 1.1 objectives:   
By the end of the learning outcome, the trainees will be able to: 

1. Understand the advantages and disadvantages of using types of interior branding 

2. Identify the characteristics of types of interior branding 

 

Resources 

Equipment  Tools Materials  

- Books 
- Computers 
- projector 
- Board   
- Flip chart 

- Marker pen 
 

 

 

 

 

- Internet 
-Banners 
-Sample of interior 
branding 
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Advance preparation: 

Prepare a scenario that will help trainees to understand the advantages and 
disadvantages of using interior branding 

 

 

 

Indicative content 1 Advantage and disadvantage of types of interior Branding 
 

1. Digital Wallpaper 

Advantages of using Digital wall paper 

✓ Unique surface that is smooth and shine 

✓ Eye catching quality 

✓ Digital printing can be applied to a number of surfaces 

✓ Digital print wallpaper has the ability to bring empty spaces to life 

✓ It always looks new 

✓ No maintenance is needed 

Disadvantages of digital wallpaper 

✓ It is easy to tear them because they are mainly printed on papers 

✓ This is not good choose for big exhibition event  

✓ This is used mainly in low traffic areas 

2. Wall panels 

Advantages of wall panels 

✓ There are strong and durable comparing to other branding materials 

✓ You can find a variety of designs  

✓ Easy to customize the colours and sizes 

✓ Easy to create 3D look by cutting 3D panels 

✓ Will not tear very easily 

✓ Wall panel can be used to hide some wall errors 

✓ Wall panelling is an economical way to mimic art 

✓ You can create desired texture and design and add some characters 

✓ Easy to repair and replace 

Disadvantages of wall panels 
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✓ Is not good for eye catch 

✓ Is not good for advertising 

✓ Require extra skills to install wall panels  

✓ If wall panels are made in timber, they can be rotted when is in contact with water 

✓ It is expensive comparing to other type of branding 

✓ Require maintenance 

✓ It the wall panels are made in timber can fade due to climate 

3. Signage 

Advantages of using signage in interior branding 

✓ Wayfinding 

✓ Displays information that can direct people or customers to the desired place. 

✓ Identify places depending on they use 

✓ Raise safety awareness 

✓ It is DIY installation you can even place somewhere else without installation 

✓ Signage use unlimited space   

✓ flexibility to manipulate the images or content on the display unit 

Disadvantages of signages 

✓ It is expensive when you use digital display signage 

✓ It requires expert to design digital signage 

4. Large format printing 

Advantages of using large format printing 

✓ This is ideal for marketing and advertising because of the large graphics images 

✓ It is durable and strong because they are printed of durable materials such as vinyl banners 

✓ Is used for a large number of people such as exhibition events or big shows 

✓ Can be printed on different materials such as paper, vinyl, textures, metals 

✓ Eye catching and visible to public 

Disadvantages of large format printing 

✓ Expensive due to the printing sizes and materials used for printing 

✓ Require large printers that make it expensive 

✓ Large format printing is not space saving solution because it requires large surface for mounting 

5. Floor graphics 

Advantages and disadvantages of using floor graphics 

✓ The floor sticker has a strong anti-scratch performance 

✓ The installation of floor stickers is also simple and convenient 
✓ Ease to maintain 
✓ It saves the space because it is used on floor 
✓ Highly customizable depending on design, application surface and desired lifespan 
✓ Customer’s attention grabbing (High eye catching) 

✓ Installation is easy because it requires to use sticker that have sticking capability 
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Disadvantages of large format printing 

✓ If the floor graphic is made of low-quality materials, it can be damaged and repairing is 

impossible 

✓ Expensive maintenance 

✓ It requires regular maintenance to maintain the same quality of images 

✓ The floor graphic can fade due to foot traffic or shoes wearing 

Theoretical learning Activity  

• Make a group of 4 people and discuss about the advantages and disadvantages of 
the types interior branding described above. 

Points to Remember (Take home message) 

 

 
 
 
 

 

 

Indicative content 2 Characteristics of types of interior Branding 
 

 
The following are the characteristics of types of interior branding  

Digital wall paper 

a) Clear and high-quality images 

b) Unique surface 

c) Flexible  

d) Not repairable 

e) Catching attention 

Wall panels 

a) Rigid and strong materials 

b) Textured and patterned 

c) Different forms, shapes and design 

d) Natural look 

e) Can be painted to change the look or for farther maintenance 

f) Easy repairing 

g) Decorative effects 

Signage 

✓ Advantages of types of interior branding 

✓ Disadvantages of types of interior branding 
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a) Directional and safety signs show 

b) Displaying information (directing people) 

c) Catching attention 

Large format printing 

a) Big sizes that can even cover the entire wall or space 

b) Made of durable and strong materials 

c) Made in vinyl, textile and fabrics 

d) Maximise the visual look of public 

e) Whether resistance like sun and rain expose 

f) Attached with hems at the edges of banners as hanging accessories  

Floor graphic 

a) Use sticking materials 

b) Wear and whether resistance 

c) Mounting on the floor 

d) Use stickers and strong adhesive materials to adhere on the floor 

e) Fading of the floor decals  

f) Durability of branding materials 

Theoretical learning Activity  

• Ask the learners individually to brainstorm about the characteristics of types of 
interior branding 

Points to Remember (Take home message) 

 

 

Learning outcome 1.3: formative assessment 

Written assessment 

• What are the advantages of the following types of interior branding? 

• Digital wall paper 

• Wall panel 

• Signage 

• Floor graphic 

• Large format 

Answer:  

• Digital Wallpaper 

✓ Characteristics of types of interior branding 
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Advantages of using Digital wall paper 

✓ Unique surface that is smooth and shine 

✓ Eye catching quality 

✓ Digital printing can be applied to a number of surfaces 

✓ Digital print wallpaper has the ability to bring empty spaces to life 

✓ It always looks new 

✓ No maintenance is needed 

• Wall panels 

Advantages of wall panels 

✓ There are strong and durable comparing to other branding materials 

✓ You can find a variety of designs  

✓ Easy to customize the colours and sizes 

✓ Easy to create 3D look by cutting 3D panels 

✓ Will not tear very easily 

✓ Wall panel can be used to hide some wall errors 

✓ Wall panelling is an economical way to mimic art 

✓ You can create desired texture and design and add some characters 

✓ Easy to repair and replace 

• Signage 

Advantages of using signage in interior branding 

✓ Wayfinding 

✓ Displays information that can direct people or customers to the desired place. 

✓ Identify places depending on they use 

✓ Raise safety awareness 

✓ It is DIY installation you can even place somewhere else without installation 

✓ Signage use unlimited space   

✓ flexibility to manipulate the images or content on the display unit 

• Large format printing 

Advantages of using large format printing 

✓ This is ideal for marketing and advertising because of the large graphics images 
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✓ It is durable and strong because they are printed of durable materials such as vinyl banners 

✓ Is used for a large number of people such as exhibition events or big shows 

✓ Can be printed on different materials such as paper, vinyl, textures, metals 

✓ Eye catching and visible to public 

• Floor graphics 

Advantages and disadvantages of using floor graphics 

✓ The floor sticker has a strong anti-scratch performance 

✓ The installation of floor stickers is also simple and convenient 

✓ Ease to maintain 

✓ It saves the space because it is used on floor 

✓ Highly customizable depending on design, application surface and desired lifespan 

✓ Customer’s attention grabbing (High eye catching) 

✓ Installation is easy because it requires to use sticker that have sticking capability 

 

• Match the following types of interior branding with their characteristics 

  
TYPES OF INTERIOR BRANDING CHARACTERISTICS 
1. DIGITAL WALLPAPER 

2. SIGNAGE 

3. FLOOR GRAPHIC 

4. LARGE FORMAT PRINTING 

5. WALL PANEL 

a) Different forms, shapes and design 

b) Directional and safety signs show 

c) Maximise the visual look of public 

d) Wear and whether resistance 

e) Clear and high-quality images 

 
 

Answer:  

1. e 

2. b 

3. d 

4.c 

5.a 
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LEARNING UNIT 2: SELECT AND CHECK TOOLS, MATERIALS AND EQUIPMENT    

 

Picture/s reflecting the Learning unit 2 

 

 

 

STRUCTURE OF LEARNING UNIT        

Learning outcomes: 

2.1 Select tools 

2.2 Select equipment 

2.3 Select materials 

 

 

Learning outcome 2.1 Select interior branding tools. 

 

Duration: 10 hrs 
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Learning outcome 1.1 objectives:   
By the end of the learning outcome, the trainees will be able to: 

1. Select tools used for interior branding 

2. Understand the use of interior branding tools 

 

Resources 

Equipment  Tools Materials  

- Books 
- Computers 
- projector 
- Board   
- Flip chart 

- Marker pen 
 

 

 

 

 

 

 

 

- Internet 
-Banners 
 

 Advance preparation: 

• Take trainees in workshop and perform together the selection of tools 
and equipment depending on the type of branding you are going to 
execute 

 

 

 

Indicative content 1 Types of Interior branding tools 
 

The following are the tools used when performing interior branding. 

1. Cutter: is a tool used when you want to cut branding materials like, vinyl banner, papers, or same 

branding textile materials 
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2. Screwdriver: Screwdriver is a type of hand tool used for the insertion and removal of screws. 

 

3. Washer: is machine component that is used in conjunction with a screw fastener such as a bolt 

and nut and that usually serves either to keep the screw from loosening or to distribute the load 

from the nut or bolt head over a larger area. For load distribution, thin flat rings of soft steel are 

usual  

4. Masking tape: an adhesive tape used to mask and protect surfaces surrounding an area to be 

painted 

 

5. Screw holder:  Screw holders or anchors as the name implies, are the small tools inserted into 
wall to hold screw into wall, typically made from plastic, metal, or fibre, which enable the 
attachment of screws into loose materials like cement brick, clay brick or in dry wall 

 

 

6. Holders and clamps: Clamp or holder is a device designed to press two or more parts together so 

as to hold them firmly. 
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7. Pencil: a tool also used in interior branding especially for sketching or drawing 

 

 

8. Tape measure:  A tape measure, or measuring tape is a type of hand tool typically used to measure 

distance or size. 

 

9. Spirit level: A level is a tool used to determine whether a surface is horizontal (level) or vertical 

(plumb). 

 

10. Roller and brushes: Are both tools used to apply paint on the surface. In branding roller and brushes 
are used especially wall panels and signage, floor graphic branding and other interior branding where 
the use of paint can be necessary. 
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11. Pins  

A pin is a device used for fastening objects or fabrics together. This is used in 

interior branding like holding temporary the branding banners or other materials 

before permanent faltering. 

   

12. screw gun 

A screw gun is similar to a power drill, but designed specifically for driving screws. A screw gun 

looks like a drill, but has a "nose" instead of a chuck. The nose holds an interchangeable 0.25 

inches (6 mm) shank bit, commonly known as a tip. 

 

Theoretical learning Activity  

• Ask trainees individually to brainstorm about the tools used for interior branding 

Points to Remember (Take home message) 

 
 
 
 

 

 

✓ Type of interior branding tools 
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Learning outcome 2.1: formative assessment 

Written assessment 

1. Choose by writing correct letter which is corresponding to  by true interior 
branding tools 

1. Trowel 

2. Hammer 

3. Computer 

4. Screw driver 

5. Screw gun 

6. Clamp 

7. Glue 

8. Pencil 

2. The following table is composed by types of tools used in interior branding design   

match column A and column B accordingly.        /10marks 

Answers Column A  Column B 

 

1…… 

1. also known as glue is any non-metallic 

substance applied to one or both surfaces of 

two separate items that binds them together 

and resists their separation 

a. Square 

 

2…… 

2. a short, slender, sharp-pointed metal pin 

with a raised helical thread running round it 

and a slotted head, used to join things 

together by being rotated so that it pierces 

wood or other material and is held tightly in 

place 

b. Tape measure 

 

3……. 

3. is a thin plate (typically disk-shaped, but 

sometimes square) with a hole (typically in 

the middle) that is normally used to distribute 

the load of a threaded fastener, such as 

a bolt or nut. Other uses are as a spacer, 

spring (Belleville washer, wave washer), wear 

pad, preload indicating device, locking 

device, and to reduce vibration (rubber 

washer). 

c. Pin 

 

4……. 

1. Is an easily removed adhesive tape 

used temporarily for defining margins, 

protecting surfaces, etc., as when 

d. Screw driver 
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painting, and sometimes also for 

binding, sealing, or mending. It is 

available in a variety of widths. It 

is used mainly in painting, to mask off 

areas that should not be painted. 

 

 

5……... 

5. is an expanding metal shell that wedges 

itself into a drilled hole upon insertion and is 

used to retain a screw in material (as 

concrete, brick, or tile) otherwise unsuitable 

e. Screw gun 

 

6…… 

6. is an instrument  used in interior design  

whose work is cutting or involves cutting 

wood/glass. 

f. Cutte 

 

7…….. 

7. is similar to a power drill, but designed 

specifically for driving screws. looks like a drill, 

but has a "nose" instead of a chuck. The nose 

holds an interchangeable 0.25 inches (6 mm) 

shank bit, commonly known as a tip. 

g. Screw anchor 

 

8…. 

8. a tool with a flattened or cross-shaped tip 

that fits into the head of a screw to turn it. A 

hand tool for turning a screw, consisting of a 

handle attached to a long, narrow shank, 

usually of metal, which tapers and flattens 

out to a tip that fits into the slotted head of a 

screw. Examples from the Web for 

screwdriver. It was a tool you used to perform 

a function, like a screwdriver 

h. Masking tape 

 

9…. 

9. a thin piece of metal with a sharp point at 

one end and a round head at the other, 

used for fastening pieces of cloth, paper 

i. washer 

 

10…. 

10. Steel tape measure rules have often a small sheet-metal angle which 

makes it easy to apply it at the work piece edge 

J. Screw 

 k. Adhesive 
 

3. Rename the following tools used in interior branding design and illustrate their main 

usage         

No Tools  usage 

1 
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2 

 

 

3 

 

 

4 

 

 

5 

 

 

 

4.What are the types of stickers used in interior branding . 

5. What are styles of banners. 

 

Learning outcome 2.2 Select interior branding equipment 

Duration: 10 hrs 

Learning outcome 1.1 objectives:   
By the end of the learning outcome, the trainees will be able to: 

1. Select interior branding equipment 

2. Understand the use of interior branding equipment 

Resources 

Equipment  Tools Materials  

- Books 
- Computers 
- projector 

- Marker pen 
 

- Internet 
-Banners 
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- Board   
- Flip chart 

 

 

 

 

Advance preparation: 

• Provide interior branding equipment in class to be used as teaching aids 

• Provide videos to demonstrate to the trainees the different types of 
interior branding equipment 

 

 

Indicative content 1 Interior branding equipment and their usage 

 

The following are the equipment used in interior branding with specifications and their uses 

1. Computer 
A computer is a device that accepts information (in the form of digitalized data) and manipulates it for 
some result based on a program, software, or sequence of instructions on how the data is to be 
processed. 
A computer is composed by two parts: 

• Hardware 
 

• Software 
computer hardware:  is the physical components that a computer system requires to function. 
Examples of hardware in a computer are the keyboard, the monitor, a circuit board, the motherboard, 
graphics card, CPU (Central Processing Unit), ventilation fans, webcam, power supply. 

Computer hardware components and specifications 
The cost of hardware depends on its specification, which in turn is determined by some key 
components. 

When you buy PC hardware, you need to decide what the specification of these key components should 
be. 

Central processing unit 
The processor is the driver of the computer. Processors are usually differentiated by speed, measured 
in gigahertz (GHz). The higher the GHz, the faster the computer will run. You should buy the fastest 
processor you can afford, but dual or quad-core processors running at speeds of 2 GHz or above will 
normally be enough for your design. 

Random access memory (RAM) 
The processor uses memory to run programs. Generally, the more RAM you have, the better your 
computer will run when using several programs at once. Your computer should have enough memory to 
make the most of the processor speed. To use multiple modern software applications effectively, you 
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should have at least 2 gigabytes (GB) of RAM and preferably 4 GB or above for more memory intense 
software applications, such as design, photography or video editing. 

Hard disk 
The hard disk stores the data you create in your business, as well as the programs you use. A typical 
office computer will have at least 500GB of hard disk space. Some new laptops and specialist 
performance computers come with solid state drives (SSD). These drives are silent because they have 
no moving parts and are five to eight times faster than the standard magnetic hard disk drives used in 
most desktop computers. Although SSD can offer significant performance advantages, the cost per GB 
of storage is approximately four times more expensive for the same storage capacity. 

 

You can use external plug-ins, such as USB memory sticks and portable external hard drives, to 
supplement your computer's storage requirements. 

 

Peripherals 
The monitor is the computer's display screen. Liquid Crystal Display (LCD) or flat screen monitors offer 
reduced bulk and lower power consumption, relative to the older style cathode ray tube (CRT) 
monitors. Monitors are normally measured diagonally in inches - typically 19, 22 or 24 inches. Larger or 
wide-screen monitors allow you to compare two documents on-screen. Many monitors have an aspect 
ratio - the proportion of image width to height - of 16:10, although screens with a 16:9 ratio are 
becoming more widely available and offer higher resolution.  

 

The keyboard and mouse usually come as part of a bundle, but you may be able to select wireless 

devices that make desktops neater. 
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Software 

Software is a set of instructions, data or programs used to operate computers and execute specific 

tasks. Opposite of hardware, which describes the physical aspects of a computer, software is a generic 

term used to refer to applications, scripts and programs that run on a device. Software can be thought 

of as the variable part of a computer, and hardware the invariable part. 

Software is often divided into categories. Application software refers to user-downloaded programs 

that fulfil a want or need. Examples of applications include office suites, database programs, web 

browsers, word processors, software development tools, image editors and communication platforms. 

System software includes operating systems and any program that supports application software. 

Software used in interior branding: 

✓ Adobe photoshop 

✓ Adobe illustrator 

✓ Logo creator 

✓ Sketchup 

2. printer  

A printer is an output device that prints paper documents. This includes text documents, images, 

drawings or a combination of all. The two most common types of printers are inkjet and laser printers. 

Inkjet printers are commonly used by consumers, while laser printers are a typical choice for businesses. 

 

 

 

        

                                                         Inkjet printer                                       Laser jet printer 

 

What's the difference between an inkjet printer and a laser printer?  

https://searchnetworking.techtarget.com/definition/hardware
https://whatis.techtarget.com/definition/script
https://searchwindowsserver.techtarget.com/definition/system
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An inkjet printer uses ink to print documents, while a laser printer uses a laser to print documents. 

Features and technical specifications that you should pay attention to when buying your next printer: 

✓ Type of Printer - Inkjet vs Laser 

✓ Ink type - Monochrome vs Colour 

✓ Printer vs All in One 

✓ Print Speed 

✓ Duplex Printing Support 

✓ Automatic Document Feed 

✓ DPI - Print Quality 

✓ Paper Tray Capacity 

✓ Duty Cycle 

✓ Cartridge Capacity 

✓ Connection Interface - USB, Bluetooth, Wi-Fi, Cloud, NFC 

✓ Scanner Resolution 

✓ Copy Speed 

✓ Printer memory / RAM 

✓ Security and Encryption Support 

1. Type of Printer 

The most important feature is considered is the printing technology, that is Inkjet or Laser. There are 

other less popular technologies besides these, but these are the best ones. 

Inkjet 

An Inkjet printer is a printer that makes use of ink and sprays droplets onto the paper. It is more popular 

since it is usually cheaper and smaller than Laser printers, making it a suitable choice for households. 

Inkjet Technology 

These printers can print both text and images, and can also print high-quality coloured images. One of 

its major disadvantages though is that the ink from its cartridges can dry up if it is not used often. 

Laser 

Laser printers make use of toner. They melt the toner powder and print it onto the paper. The printer 

itself is more expensive than inkjets and the toner is more expensive than the ink cartridges as well. But 

it can print both monochrome and coloured documents faster and more efficiently. 
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Laser Toner Cartridge 

Laser printers can print large volumes of documents frequently without any problem, making it the go-

to option for busy offices. 

Laser printer toners do not dry up like inkjet cartridges giving and overall lesser printing and 

maintenance cost in the long run. 

2. Monochrome or Color 

A monochrome printer is a printer that prints using only black ink. Monochrome inkjet printers are rare 

and most of the common models are Laser printers. Laser Monochrome printers have better print 

quality and faster print speeds. 

If you are planning to buy a printer for office use or document printing at home then Monochrome 

Laser printers are the best option. Their print quality is superior and the overall printing cost is low. 

 

Colour Vs monochrome printers 

Colour 

A colour printer is a printer that can print more than one colour. Colour printers can have separate Cyan, 
Magenta, Yellow, and Black cartridges or can have a single colour and a single black cartridge, depending 
on the model. 

Colour printers can print not only text but can also high-quality pictures. Low-quality colour printers 
might lower colour saturation when printing while the best colour printers can replicate high-quality 
images without sacrificing colour quality. 

If you absolutely need to print colour images or logos for example, then colour inkjet or ink tank printers 
are your best option. Though keep in mind that inkjet printers run the risk to inks drying up soon making 
it necessary to get a refill or replacement. 

3. Printer Only vs All-in-one Machine 

Printer Only 

These are the most basic printers and their price varies, depending on the features. The more 
economical models are only printers and cannot do anything else. 
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However, some printer only models can be very specialized machines used in big businesses with specific 
features like Wi-Fi compatibility, duplex printing, colour printing, automatic document feeder, and more. 

These additional features make it efficient and more productive. 

 

Brother Monochrome Laser Printer, HL-L5200DWT 

3D printer 
3D printer is printer used to print out three dimensional solid objects from a digital file.3D printing is the 
process of making an object out of some material, often plastic.  

Most commonly, the 3D printer will have a nozzle ejecting a semi-liquid material, like molten plastic, 

metal, or cement. The extrusion nozzle can move in both horizontal and vertical directions as it 

precisely places the material, following the blueprint of the digital model layer by layer. 

This process is repeated until the 3D printer has replicated every layer in the digital model with the 

extruded material. 

 
 

For interior branding, you can use 3D printer for making signage or other types of decors for interior 
branding 
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Drilling machine 
Drilling is a device used to create a hole in the wall, like when you want to instar anchors which will 
holds screws for attaching the banners, wall papers, wall signages. 

 

 

 

Screw gun 

A screw gun is similar to a power drill, but designed specifically for driving screws. A screw gun looks 

like a drill, but has a "nose" instead of a chuck. 

 
Compressors 

Compressors are mechanical devices used to increase pressure in a variety of compressible fluids, or 

gases, the most common of these being air. Paint sprayers compressor machine can be used to spread 

paint on the wall or during designing branding and cleaning large surface. 
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Welding machine 

welding machine can be used to join the metal frame either for attaching branding panels to wall or other 

uses need to join metal. 

 
 

 

Theoretical learning Activity  

• Take trainees to workshop before starting lesson and ask one by one to pick 
equipment related to the types interior branding  

Points to Remember (Take home message) 

 
 
 
 

 

Learning outcome 2.2: formative assessment 

Written assessment 

1. List any types of equipment used in interior branding 
2. What are the specifications of a good computer for designing interior branding? 
3. What are the specifications of a good printer that can be used for printing interior 

branding designs? 
4. Differentiate 2D printer from 3D printer 

✓ Types of interior branding equipment 

✓ The use of interior branding equipment 
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Learning outcome 2.3 Select interior branding materials 

Duration: 10 hrs 

Learning outcome 2.3 objectives:   
By the end of the learning outcome, the trainees will be able to: 

1. identify types of interior branding materials 

2. Identify different characteristics of interior branding materials 

 

Resources 

Equipment  Tools Materials  

- Books 
- Computers 
- projector 
- Board   
- Flip chart 

- Marker pen 
 

 

 

 

 

 

 

 

- Internet 
-Banners 
 

Advance preparation: 

• Provide interior branding materials in class and demonstrate them to 
the learner to have more understanding about them 

 

 

Indicative content 1 Types of interior branding materials and its characteristics 

 
Branding is very crucial for any business to sustain in the market. Branding the business or your new 

product is important for you to gain customers and make sales. You need to be more creative and 
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innovative to take your business to the people. Promoting a business seems quite easy until you actually 

start it. But it requires a lot of effort to create good branding and to stand out among the existing 

businesses. There are many ways to build branding for your business. And the results completely rely on 

how you implement them. 

1. Banner 

It’s a simple yet effective solution that’s worked for decades. Whether you’re advertising a sale at a 

retail store or attempting to attract new restaurant patrons, signs and banners are a great way to lure in 

new business. Outside of sales and advertising, banners are a great way to celebrate a special occasion, 

like a birthday, or show support for loved ones during a race, sporting event, or other milestone. 

 Types of banners by materials: 

✓ Vinyl 

✓ Mesh Vinyl 

✓ Adhesive Vinyl 

✓ Polyester Fabric 

✓ Canvas 

With so many materials to choose from, how do you make sure you select the best type? It really boils 

down to your intentions and visions for your banner or sign. Is the banner going to be indoors or 

outdoors? Do different materials have better ink compatibility for certain colors? Have you made a 

decision between vinyl vs fabric banners? 

Below, we’ll highlight some of the most popular types of signage material, the characteristics of each, 

and their respective benefits and drawbacks. 

1. Vinyl Banner Material (PVC Banners) 
For outdoor use, vinyl is heavy-duty, tear-resistant, and more water-resistant than canvas or polyester. 
Vinyl banners are typically offered in a semi-gloss finish that’s super smooth, but you can also get them 
in a matte finish. If you’re looking for a banner you can hang outside without worrying about the 
elements, then any of the three types of vinyl banners are a logical option for you.  

 

 

 

2. Mesh Vinyl 

https://www.halfpricebanners.com/signs
https://www.halfpricebanners.com/banners
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Like vinyl, mesh vinyl has waterproof and fade resistant qualities. 

The difference is that this material has tiny holes in it, which allows 

air to pass through and makes the material more breathable. 

Because of this mesh quality, mesh vinyl has a longer lifespan than 

traditional vinyl. Another advantage of mesh vinyl is that it’s wind 

resistant. As air passes through the holes, it moves quietly and 

prevents the banner from flapping in the wind. That makes this 

material perfect if you’re looking to hang a fence banner. 

Mesh vinyl banners are a great investment if you’re seeking a long-term solution that will last for years 

to come. This material is more expensive than standard vinyl, but if you need a banner that you can 

reuse often for many years, it’s a solid investment. 

3. Adhesive Vinyl Banners 

Adhesive vinyl banners are an excellent alternative to free-standing 

banners. If you have a wall, window, or smooth surface that you can 

hang the banner from, an adhesive vinyl banner might be the perfect 

choice for you. Like standard vinyl banners, this material is waterproof, 

fade resistant, wrinkle resistant, and durable.  

One of the biggest advantages of adhesive banners is that they stick to a 

surface, so you don’t have to worry about your banner blowing over or flapping loudly in the wind. You 

can also forgo purchasing bungee cord or poles and simply apply your banner to an existing structure 

for easy installation. 

4. Polyester Fabric Banners 

Fabric banners offer sharp, high-quality colour and photo quality 

prints for professional looking advertising. Ideal for indoor use, 

these polyester fabric banners are printed with a dye-sublimation 

process that creates vibrant photo-quality colour. Thanks to their 

fabric material, polyester banners are scratch-resistant. 

Because polyester is a fabric, this sign material isn’t suitable for 

most outdoor environments. However, if you will only be using your 

banner outside in mild weather for a few hours, this might be a 

good option for you. 

If you’re considering purchasing a polyester banner, bear in mind that this material can be prone to 

ripping or tearing. Therefore, these banners are best used when handled carefully indoors. 

 

 

5. Canvas Banners 

 

https://www.halfpricebanners.com/mesh-vinyl-banners
https://www.halfpricebanners.com/adhesive-vinyl-signs
https://www.halfpricebanners.com/fabric-banners
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Many canvas banners are made of premium cotton duck canvas — a 

highly durable material that’s been used in heavy-duty applications 

such as workwear and boat sails for many years. Canvas is one of the 

highest quality materials thanks to its wind-resistant quality and 

artistic aesthetic. Just like fine works of art, canvas banners offer a 

professional look and oftentimes look hand painted thanks to their 

semi-gloss finish. This adds an element of class to any event or 

promotion. The woven texture of canvas also adds a nice touch for 

those who are looking for an aesthetically pleasing option. 

Canvas allows text and images to be printed in high resolution, which makes this an excellent choice for 

those who value appearance above all else. Although this material is heavy-duty, canvas banners are 

best used indoors in order to preserve the imagery’s quality. 

Types of banners by style 

1. Pull-Up & Retractable Banners 

Pull-up banner stands, also known as roll-up, are an attractive, double-sided solution for tradeshow 
events and indoor retail signage. They tend to be around six-feet tall with varying widths dependent on 
custom specifications. Cheaper than their pop-up alternatives (which we will touch upon later), pull-up 
banners are easy to collapse and transport. 

As you might imagine, their retractable system allows for almost instantaneous setup, but this comes as 
a price: pull-up banners can’t be built much wider than five feet. If you have a smaller exhibition, or 
want to supplement your existing signage and displays, perfect; otherwise, you may want to investigate 
pop-up displays instead. 

 

2. Backwall Displays and POP Displays 

Guess what pop-up displays do? They “pop” up! Often made of fabric, these are only banners in 
the loosest sense of the word, but they have the same end-goal as traditional banners: getting 
people’s attention. Often, pop-up booths are used to extend across the entire back of an 
exhibition’s shell. 

https://www.halfpricebanners.com/canvas-banners
https://www.signsbytomorrow.com/blog/banner-stands
https://www.signsbytomorrow.com/trade-show-displays/pop-displays
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Have big expectations for your signage? Because of their sturdier support and dimensional 
nature, pop-up displays can stretch much wider than a retractable banner. Installation may not 
be as convenient as a pull-up banner, but a few minutes should be enough for setup and 
takedown. 

 

3. Step and Repeat Banners 
These are the perfect choice if you’re looking for large signage that dictates the background scene. 
They’re designed to set the mood of an event and to create brand awareness. Some of the most 
creative designs are printed on backdrops. 

They can be printed on vinyl, canvas, polyester, as well paper. Most backdrop banners are large. The 
size depends on the capability of the printer and the available space allowed for placement. These 
popular signs are used by photographers, trade show exhibitors and others. An average size can range 
somewhere between 4′ x 4′ and 20′ x 10′. 

Some backdrops are mounted to adjustable stands, draped over walls, taped or other mounting 
techniques. Banner backdrops can by heavy or light it all depends on the size and fabric / material used. 

This type of sign can be printed in a variety of ways. They’re printed using dye-sublimation technology, 
with solvent and eco-solvent inks, as well as latex printing options. 

The design varies by individual or company. Many companies prefer step and repeat patterns that run 
across the entire surface of the banner. A step and repeat pattern is used to create brand awareness. 

So, why not take advantage of this drab affair with custom branding? Step and repeat banners allow 
you to cover up garish wallpapers and boring backgrounds, all while marketing your company’s logo and 
name. The repetition of your logo or pictograph on their fabric allows them to slip into the scenery, 
while promoting awareness of your business through photography and video. 
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4. Pole Banners 

Outdoor pole banners, also known as boulevard banners, are often seen on the streets and avenues of 
downtown districts, promoting festivals, concerts and events. However, they can be used for a variety 
of other purposes, such as decorating the main thoroughfares of colleges and universities, promoting 
retail spaces like shopping malls, or adding a splash of color to casinos, hotels and entertainment 
spaces. 

Usually printed onto durable vinyl material in square or rectangle shape, pole banners can be installed 
using hardware kits that allow you to affix the banner to the pole using two extended arms or brackets. 
For added wow factor, use two banners side-by-side per pole! 

 

5. Framed Banners 

Practically any banner can be framed similarly to the framed wall art you see in offices and homes. This 
is a great way to give the banner a more sleek, professional and permanent appearance. Because the 
fabric becomes more taught, there’ll be far fewer unwanted wrinkles or environmental disturbances 
such as wind. 

 

https://www.signsbytomorrow.com/banners/outdoor-pole-banners
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6. Feather Banners (AKA Feather Flags) 

Of course, sometimes wind can be your friend, such as in the case of feather banners. Lightweight, 
portable and economical, these roadside staples are often seen outside retail spaces, showcasing 
messages such as “Now Open” or “On Sale.” They’re often made from aluminum poles and polyester 
fabrics that are durable but also highly moveable, creating an animated, hard-to-miss signal whenever 
drivers or pedestrians go by. 

 

7. Suspended Banners & Hanging Banners 

Using cables and rods, hanging banners can be displayed above crowds for maximum visibility and 
promotional impact. While installation for ceiling displays may be a little more involved, the potential 
payoff can be well worth the effort. 

What comes to mind when you think of a hanging banner? Obviously, there’s nothing wrong with the 
classic fabric-suspended-by-two-corners design, but almost any shape you can dream up – circular 
hanging displays, elliptical suspended banners, triangle ceiling hangings, square display systems – is 
available at Signs by Tomorrow. 

 

2. Stickers 

The following are the types of stickers materials 

1. Clear vinyl 

Great for stickers without a white background. Perfect for indoor and outdoor use. 
Regular stickers are 9mm thick. Apply to smooth flat surfaces such as glass, metal, 

https://www.signsbytomorrow.com/banners/feather-banners


59 
 

wood, and plastic. Includes a free layer of lamination. Weatherproof, scratch-
resistant, and protected from UV rays. Easy to remove. Leaves no residue behind. 
Lasts up to 5 years. If you want your Clear Vinyl sticker to be placed on the inside of a 
window facing out, it is recommended that you reverse-print your design. 

 

2. Front-Facing Cling 

Intended for indoor use. Apply to the inside of a window and view the sticker from the outside. 
Available with or without a solid white backing. Front-facing cling stickers are 7mm thick. Front-
facing adhesive stickers include a free layer of lamination, making them scratch-resistant and 
protected against UV rays. They are easy to remove and leave no residue behind. Lasts up to 5 
years. We create this type of sticker by reverse printing your design on clear vinyl with a layer of 
white ink behind the design. This inside application technique makes your sticker's colors stand out 
and prevents any ink from staining your window. 

 

3. Glow in the Dark Vinyl 

Our printable Glow in the Dark vinyl emits a bright greenish glow in darkness once it has been 

exposed to natural or artificial light. It will glow the brightest during the first 10 minutes but will 

remain visible in darkness for up to 1 hour. The brighter white appearance of the Glow in the 
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Dark vinyl makes it perfect for multi-colour graphics, signage, interior labels, and other custom 

printed products. 

Glow in the Dark vinyl is easy to apply to a wide variety of smooth, flat substrates, such as sign 

blanks, painted drywall or painted metal. It is also easily removable and leaves no adhesive 

residue behind. 

Designed for CPSIA compliance, our Glow in the Dark vinyl is lead-free, eco-friendly and child-

safe. Its phosphors are derived from natural rare earth minerals, which are non-toxic and non-

radioactive. 

 

4. Permanent Adhesive 

Permanent Adhesive White Vinyl is intended as a permanent sticker solution. Select when looking to 
achieve a permanent sticker that you do not plan on removing. Permanent Adhesive is perfect for 
outdoor use as it is weatherproof and can withstand elements like UV rays, rain, and snow. They are 
ideal for difficult surfaces like steel containers, dumpsters, steel drums, and more. 

 

5. Reflective Vinyl 

Reflective vinyl decals are produced from a high-quality adhesive vinyl material that illuminates and 
reflects back direct light. These reflective vinyl decals can be placed on any flat, smooth surface, 
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including metal, glass, wood, plastic and more. They show up exceptionally well at night from 
passing vehicle headlights. 

Reflective vinyl decals are printed with a full-color design on one side and adhesive on the other. 
Reflective vinyl is also available in multiple colors for one-color cut-out stickers. Intended for outside 
application only. 

 

6. White Vinyl (Most Popular) 

Perfect for indoor and outdoor use. Regular white vinyl stickers are 9mm thick. Apply to smooth 
flat surfaces, including glass, metal, wood, and plastic. Stickers include a free layer of lamination. 
Weatherproof, scratch-resistant, and protected from UV rays. Easy to remove and leaves no 
residue behind. Lasts up to 5 years. 

Most commonly, vinyl decals are printed with a full-color design on one side and adhesive on the 
other, but a front-facing adhesive option is also available for inside application. 

 

7. White Cling 

Perfect for indoor and outdoor use. White cling stickers are 7mm thick. Apply to smooth flat 
surfaces, including glass, metal, wood, and plastic. Stickers include a free layer of lamination. 
Weatherproof, scratch-resistant, and protected from UV rays. Easy to remove and leaves no 
residue behind. Lasts up to 6 months. 

White Cling stickers are printed with a full-colour design on one side and have the low tack 
adhesive on the other. If you want your cling sticker to be placed on the inside of the glass with 
the design facing out, it is recommended that you use the Front-Facing Cling option, which will 
print your design in reverse on clear cling and then add a layer of white ink on top of the design 
to increase visibility and help your design pop. 
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8. Magnet 

Magnet material has a white vinyl topcoat to make them printable. They come in two 
thicknesses, 20 mil for indoor use and 30 mil for outdoor use. Apply to any magnetic surface, 
including iron, nickel, cobalt, and steel. They are weatherproof, withstanding elements like UV 
rays, snow & rain. Will last up to 6 months. 

Make sure the area where you want to place the magnet is fairly flat and that the entire surface 
is metal. If some areas are plastic or fiberglass, gaps can form, allowing wind to get under your 
magnetic sign and pull it off. Therefore, it is important to test the entire surface for proper 
magnetic adhesion. 

 

9. Clear Cling 

Perfect for indoor and outdoor use. Clear cling stickers are 7mm thick. Apply to smooth flat 

surfaces, including glass, metal, wood, and plastic. Stickers include a free layer of lamination. 

Weatherproof, scratch-resistant, and protected from UV rays. Easy to remove and leaves no 

residue behind. Lasts up to 6 months. 

Clear cling stickers are printed with a full-color design on one side and have the low tack 

adhesive on the other. If you want your cling sticker to be placed on the inside of the glass with 

the design facing out, it is recommended that you use the Front-Facing Cling option, which will 

print your design in reverse on clear cling and then add a layer of white ink on top of the design 

to increase visibility and help your design pop. 

 

10. One way vision or Perforated Film sticker 
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Perforated Film creates one-way visibility with its perforated vinyl pattern. This mesh pattern offers 
enough print surface area for the custom image to appear solid from the outside, with a subtle opacity. 
When viewing from inside, the window will appear tinted but will not lose visibility. 

Perforated Film comes in both 50/50 and 70/30. The first number in this designation represents the 
amount of printable space while the second number represents the amount of open (see-through) 
space. Therefore, a sticker made from Perforated Film at 70/30 has a larger printable area, but less see-
through area, than a sticker made from Perforated Film at 50/50. 

Perforated Film is weatherproof, so it can withstand elements like UV rays and rain. It is intended for 
outdoor application on windows and will not leave adhesive residue when removed. 

 

 
3. Wood  

It’s no secret that branding irons are most commonly used to brand wood. You can brand any 

type of wood you like, including hard woods and soft woods. Remember though that the 

darker the wood, the harder it will be to read the mark. 

 

What about finished wood? Can I use a branding iron on finished wood? We recommend that 
brands are not applied to wood that has been clear coated or painted. Non-polyurethane 
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stains can be branded over if they are dry, but in general it's best to brand unfinished wood. 
Lacquer and polyurethane are likely to burn, bubble, and scorch, which makes the branded mark 
look ugly. 

Whether you are handcrafting a wooden table or have just purchased a candle with a wooden  
lid from a boutique store that you’d like to personalize for your own home, or for a gift, adding a 
signature or image can add that unique touch you’re after. 

 

Theoretical learning Activity  

• Ask learners to make a group on 4 people and discuss about the types of materials 
used in interior branding and their characteristics 

Points to Remember (Take home message) 

 
 
 
 

 

Learning outcome 2.3: Formative assessment 

Written assessment 

1. Match the following types of interior branding with types of interior branding 

Types of interior branding  Interior branding materials 
1. Digital wall paper 
2. Signage 
3. Wall panel 
4. Floor graphic 
5. Large format printing 

a) Metal 
b) Paper 
c) Vinyl banner 
d) Wood 
e) Viny sticker 

✓ Types of interior branding materials 

✓ Use of each material according to the type of interior branding 
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LEARNING UNIT 3: DEVELOP INTERIOR BRANDING DESIGN 

 

Picture/s reflecting the Learning unit 3 

 

 

 

 

 

 

 

                                              

STRUCTURE OF LEARNING UNIT        

Learning outcomes: 

3.1 Create interior branding theme 
3.2 Generate interior branding drawings 
3.3 Prepare interior branding color scheme 
3.4 Develop presentation of the project. 
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Learning Outcome 3.1: Create interior branding theme 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Indicative content 1 Types of themes 
 

What is theme? 

A theme is an idea, concept, or lesson that conveys a moral message in a text and explores it through 
characters, setting, dialogue, plot, or elements. 

The following are the types of branding themes 

✓ Cultural theme  
✓ Museum/historic theme  
✓ Travel/tourism theme  
✓ Religious theme  

Duration: 5 hrs 

Learning outcome 3.1 objectives:   
By the end of the learning outcome, the trainees will be able to: 

1. identify types interior branding theme 

2. identify style of interior branding theme 

3. identify characteristic of style of interior branding theme 

Resources 

Equipment  Tools Materials  

- Books 
- Computers 
- projector 
- Board   
- Flip chart 

- Marker pen 
 

 

 

- Internet 
-Banners 
 

Advance preparation: 

• Provide tutorials for more understanding the design concept of interior 
branding 
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✓ Commercial theme 
1.1. Cultural theme 

Themes are the specific expressions of cultural integration in each individual case. Opler illustrated how 
this concept may be used in his account of the Apache life way. The concepts of patterns and themes are 
both keys to the specific structure and character of a way of living. 

Examples of cultural theme 

• Humans and Environment.  

• Cultural Identities, Cultural Diversities and Intercultural Relations. 

• Cultural Heritage. 

• History, Memory and Politics. ... 

• Scholarly work in a changing context. 

1.2. Museum/historic theme 

A historical theme is an interpretive thesis that can use evidence (primary sources) from several different 
eras to support it. Ideally, this thesis should be a single sentence. Examples: Portrait painting reflects the 
insecurity of the upper classes. 

Examples of historical themes 

• Archaeology. 

• Architecture. 

• Aviation. 

• Black History. 

• Cartography. 

• Christianity. 

• Civil Rights. 

• Cultural interaction 

• Political structures 

• Economic structures 

• Social structures 

• Human-environment interaction. 

1.3.  Travel/tourism theme 
Travel Tourism offers a flexible and highly customizable layout for designing a website that looks out of 
the box and represents your tourist guide, accommodation, bed and breakfast, booking, holiday, travel 
agency, hostel, Wellness Resort, Hotel Booking, Vacation Planning & Holiday Trips, Medical tourism & 
Travel business itinerary tours, hotels, tour operator, itineraries, travel management system, travel 
agents, Adventure Travel Destination Explorer, corporate travel, Traveller Review Blog Template, travel 
company, travel club, travel listing directory, Vacation Planning & Holiday Trips, Medical tourism & Travel 
business itinerary, Yacht boating, Sailing Rental, cruise travel, road tripping, cultural tourism, Culinary 
Tourism, travel blogs focussed on photography, Trivia about the destinations, Travelers, motel, 
Immigration support, Visa & Passport services, Package tours, Honeymoon travel, reservation, resort and 
trip Vacation. The gallery can be effectively used to show pictures of travel destinations, tips, and highlight 
your facilities. Its professional design comes with skilfully crafted sections and an attractive banner that 
shows pictures related to your work. 

Examples of tourism themes 
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• Nature-based tourism and ecotourism. ... 

• Tourism and climate change. ... 

• Tourist experiences. ... 

• Accessible tourism & health tourism. ... 

• Heritage tourism. ... 

• Mass tourism. 

 

1.4. Religious theme 

Religious theme is appropriate to or in accordance with the principles of a religion. 

Examples of religious themes 

• Religious regions 

• religious ecology 

• religion and society 

• religious diffusion.  
1.5. Commercial theme 

A theme of advertising is a central, recurring idea or message intended to trigger desired action from the 
customers. It is the heart of advertising copy. Some of the popular themes used in the advertisements of 
different products are given below. 

Examples of commercial themes 

• Africa slave trading 

• Commercial interaction trading 

• Rwanda cross boarder trading 

Theoretical learning Activity  

• Brainstorm about the cultural, commercial, tourism and historic theme that can be 
used in our country 

• Discuss in a group of 3 person about the different styles that can be used for 
interior branding design 

Points to Remember (Take home message) 

 
 

 

 

 

Indicative content 2 Styles of branding theme and their key characteristics 
 

✓ Types of themes used in interior branding 
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This topic describes the main characteristics of the branding styles that can be used for the different 

types of branding themes as it is described above. 

Here are the types of interior branding styles. 

• Modern 

• Rustic  

• Traditional  

• Minimalist 

2.1. Modern styles 

What is Modern branding design Style? 
In interior design, the Modern Style creates functional spaces with a delightful aesthetic. This style 
highlighting the use of clean lines, geometric form, and natural materials. Modern style in interiors evokes 
a simple yet elegant lifestyle. 

Modern Style Main Characteristics 
We already shared some of the main characteristics of the Modern Style, which highlights the clean lines, 
geometric form, and natural materials – but now we will go further and explain a little bit more about 
how it approaches the interior. 

• Clean lines 
Modern interior design evokes simplicity, and clean lines are one of the main characteristics. The designs 
with this Style present clean, straight lines and less adornment. Remember, the key to this style is to keep 
it simple, which is why less can be more here. 

• Neutral Colours 
Regarding the colours, white, beiges, and earth hues rule in modern interiors. The choice of colours aims 
to emphasize the natural materials and keep the space simple and clean. The palette colour of a modern 
interior will always highlight monochromatic and nude hues. 

• Natural Light 
Modern interiors aim to make the space feel airier and more open, and for that, the help of natural light 
is always welcome in these layouts. 

• Floor plan concept 
The key to a modern design is to keep it simple – so fewer walls are better. This style highlights the open 
floor plan concept – furniture and accessories can be an excellent choice to delimit areas in an open 
space. 

• Natural Materials 
Modern interiors highlight using natural materials, such as stone, wood, and leather. 

• Functional choices 
One of the modern style principles is that the form should follow usability. Regarding interiors, most 
decorative pieces and furniture have a purpose. 
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Difference between Modern and Contemporary Style 
Modern or Contemporary? Both words can be related as synonymous, but when regarding interior styles 
represent two different movements. The Modern Style comprehends the period of the early to mid-
twentieth century. At the same time, the contemporary doesn’t have a specific period because it is 
constantly evolving as the people, culture, and times change – reflecting the style in vogue in the present. 
In other words, we could say that the contemporary style highlights what is happening at a specific time, 
which is also a fluid style that changes as society evolves. Conversely, the modern style will always be 
identified by the same aesthetic that highlights nude hues, clean lines, and balance. 

2.2. Rustic style 

What is rustic branding design style? 

Rustic branding design represents a natural, rough, aged, and casual design style. The category is broad 

and incorporates a range of variations on the style, including Tuscan, coastal, cottage and modern 

rustic. Regardless of the variation, rustic style highlights rugged, natural beauty. The style originated 

organically and evokes a sense of past times when people repurposed items or built them from scratch. 

Most things came straight from the earth and, therefore, had a naturally organic and rustic nature. In 

this traditional sense, rustic design might seem heavy and dark. Today, however, a more contemporary 

rustic style has emerged with a fresh and light aesthetic. 

Weathered, raw wood is one of the most common materials used to create a rustic style interior. A 

predominance of wood tones and finishes, however, can create a space that feels dark and heavy. To 

lighten the space, a rustic colour palette incorporates simple and earthy colours that often balance 

white and neutral colours drawn straight from nature. Natural, organic textiles such as canvas, burlap, 

wool, and linen are often used to bring this style to life. Faux animal skins are also an option. And you 

can enhance the rustic feel of the room by adding textured area rugs made from natural materials such 

as sisal, jute or sea grass. 

Key characteristics of rustic interior design 

Rustic design style can range from traditional and dark, to light, modern and chic. While each variation 

of the design style will have its own distinct look, there are some basic design elements and decorations 

that they’ll have in common. Below are some rustic style elements and decorating ideas to get you 

started. 

• Raw, natural materials 

Start by stripping your home back to its original features. This could include natural wood, tile or stone 

floors, exposed wood beams on the ceiling, brick walls, fireplaces, or wooden door or window frames. If 

your home doesn’t have any of these features, you can create a rustic look by installing wide plank 

wood floors. These are simple and solid in appearance and provide the perfect foundation upon which 

to create a rustic style. 

• Textured, organic textiles 

Once you are designing, natural, unprinted, textured fabrics, throws and rugs will add a 

rustic warmth and cosiness to your space. Canvas, burlap, wool, linen, jute and sisal are perfect rustic 

home decor choices. 

• Non-shiny metal 



71 
 

It’s best to avoid shine and sheen in rustic spaces. Instead, when selecting light fixtures and hardware, 

opt for non-shiny metals. Repurposed metal and industrial hardware, for example, will add more of an 

old-time feel. 

2.3. Traditional branding style 

What Is Traditional Style? 

The traditional style offers a classic designs and casual décor. It is a term that includes several design 
elements, including warm colours and symmetrical lines. 
The traditional style is one of the most popular styles used to decorate homes. It incorporates design 
elements from a variety of centuries, which allows homeowners to feel comfortable and elegant at the 
same time. The traditional style features warm, rich colors that are very inviting. The traditional style 
may have curves and designs, but it is not extremely ornate or ostentatious.  

Key Characteristics of Traditional Interior Design Style 

• Furniture, décor, art rooted in European design primarily from the 18th and 19th century, 
particularly from England and France 

• Design is based on styles of the past but often finished with fewer fine ornamental details 
• Rooms are set up to be functional, family-friendly, and comfortable 
• A focus on symmetry includes conventional space planning around classic uses of space; pairs of 

furniture and objects such as armchairs or lamps; and an overhaul harmonious feel rather than a 
room full of juxtaposition and contrast 

• Interiors may include traditional architectural elements such as crown moulding and wainscoting 
• Colour palettes include subtle neutrals with sparing use of bold colour 
• Wood finishes on floors and furnishings tend to be darker  
• Walls are usually painted in muted neutrals but may include subtle patterned wallpaper in 

traditional motifs such as floral, stripes, or damask 
• Textiles are generally neutral or subtly patterned as with wallpaper and may include heavy 

cotton, wool, velvet, fur, and silk 

2.4. Minimalist branding design style 

What is minimalist interior design style? 

Most people are today familiar with the concept of minimalism, which involves stripping things down to 

their most basic form. It can be applied to anything from art and lifestyles to architecture and interior 

design. 

Minimalist interior design is very similar to modern interior design and involves using the bare essentials 

to create a simple and uncluttered space. It’s characterised by simplicity, clean lines, and a 

monochromatic palette with colour used as an accent. It usually combines an open floor plan, lots of 

light, and functional furniture, and it focuses on the shape, colour and texture of just a handful of 

essential elements. 

Key characteristics of minimalist decor style 

white and neutral colour palette 
And keeping it simple applies to your colour palette too. Go easy on the eye and let your furnishings 
take centre stage with a monochromatic colour palette. From whites to black accents, you could even 
add a bit of Beige 04 or Green 09 masquerading as white for some subtle warmth. You can layer on the 

https://www.thespruce.com/wainscotting-vs-beadboard-paneling-5093363
https://www.thespruce.com/best-wallpaper-4160860
https://www.lick.com/eu/products/paint/colour/white
https://www.lick.com/eu/products/paint/colour/black
https://www.lick.com/eu/product/beige-04-matt-paint
https://www.lick.com/eu/product/green-09-matt-paint
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texture by choosing textiles in a similar neutral colour palette—think a thick Flokati or Beni Ourain rug 
or a stylish curved bouclé sofa.  

Take a look at the best colour palettes for a minimalist bedroom from some inspiration. 

Minimalist decor characteristic: less is more 
The golden rule when it comes to minimalist decor. Less is more in every aspect, whether that refers to 
minimal decoration and ornamentation or a pared-back colour palette. You need to apply a little Marie 
Kondo magic to your decor. If in doubt, use the 'one in one out' rule. Ask yourself what items are 
essential? What can be stored out of sight? And most importantly, what can be removed completely? 
This means no clutter, no over-dressing, no beds or sofas piled high with cushions and throws. Keep. It. 
Simple. 

Minimalist decor characteristic: clean, sleek lines 
Unsurprisingly, minimalist decor focuses on clean, sleek lines, but this doesn't just apply to architecture. 
Nowhere is this more apparent than in the kitchen. Clean, sleek, open-plan kitchens are the heart of a 
minimalist home. From removing all things clutter to lots of natural light, shining marble surfaces and 
stylish storage. You can apply these elements into your minimalist decor style throughout your house, 
but to get the look in your kitchen, take a read of these 6 tips to create a minimalist kitchen.  

Minimalist decor characteristic: simplicity in form and function 
One of the key factors of minimalist decor is that it should provide a soothing space that seeks simplicity 
in form and function. A Corbusier-style chaise longue not only looks beautiful but also creates a place to 
relax. A sleek dark wood futon style bed (no, we don't mean the sofa-bed kind, we're talking traditional 
Japanese-inspired bedding) allows for a simplistic bedroom as well as great storage space. In fact, 
attractive storage allows for the chaos of life to live on the inside whilst your decor appears sleek and 
minimalist on the outside.  

Minimalist decor characteristic: clean, open, light-filled spaces 
A must in minimalist decor is to take advantage of natural light. If you're doing a complete home 
renovation, this could mean installing floor-to-ceiling glass sliding doors or skylights. If you're working 
with existing architectural elements, this means leaving windows bare. Add more light to a room by 
placing a large mirror close to a natural source of light. It's one of the oldest tricks in the book for 
making a room appear bigger and light-filled. Alternatively, furniture choices like a perspex desk or glass 
dining tables are not only practical but will prevent light from being blocked and allow it to flow 
throughout your space. 
 

Theoretical learning Activity  

• Ask trainees to discuss in group the styles of interior branding themes used in 
interior branding 

• Ask learners to write down the characteristics of styles of interior branding themes 

Points to Remember (Take home message) 

 
 
 
 

✓ Characteristics of styles of interior branding  

 

https://www.lick.com/eu/blog/understanding-different-neutral-colour-palettes
https://www.lick.com/eu/blog/the-best-colour-palettes-for-a-minimalist-bedroom
https://www.lick.com/eu/blog/6-tips-to-create-a-minimalist-kitchen
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Learning outcome 3.1: formative assessment 

Written assessment 

1. What is an interior branding theme? 
2. Explain the main characteristics of the following styles of interior branding 

theme. 
a) Modern 
b) Rustic 
c) Minimalist 
d) Traditional 

3. Give one example of the following types of interior branding themes 
a) Commercial  
b) Religious 
c) Historic 
d) Tourism 

Learning outcome 3.2 Develop an interior branding design 

 

Duration: 10 hrs 

Learning outcome 3.2 objectives:   
By the end of the learning outcome, the trainees will be able to: 

1. develop interior branding drawings 

Resources 

Equipment  Tools Materials  

- Books 
- Computers 
- projector 
- Board   
- Flip chart 

- Marker pen 
 

 

 

- Internet 
-Banners 
-Sample of interior 
branding 
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Advance preparation: 

• Prepare the computer in computer lab for design and research 

• Providing drafting tools and equipment before start designing using computer 

 

 

 

Indicative content 1 Steps of developing interior branding drawings 
 

1.1. Develop preliminary sketches 

During the development of Preliminary sketches, the initial set of sketches are used to visually convey 
concepts, designs ideas, and project requirements among design professionals, clients and other project 
stakeholders. 

Sketching is a favourite way for graphic designers to come up with some quick and unique design ideas. 
This way, the designers know what is in their mind regarding a particular subject. These instant sketches 
are different design concepts, which can be developed into a complete branding design. 

Sketching is an important aspect of creating a graphic design. Both the graphic designers and UI designers 
sketch their initial design ideas on a piece of paper. For them, sketching is the first step they take when 
they start working on a project. It gives them the complete freedom to explore their imagination and 
come out with some creative ideas. 

In fact, most of the iconic logo designs that we see around today were started first in a sketchbook. 
Many famous logos were first created as sketches. Such iconic logos started with a rough sketch of an 
idea, which they later developed gradually as per the client’s design needs. 

Every designer has a different creative process. Sketching is, however, a common habit with most of the 
designers. You can instantly sketch many ideas roughly on a piece of paper. Some designers work on the 
computer. But it is advisable to sketch first on paper. You can quickly express what is there in your mind 
without making many experiments. 

Often, the mistakes you make in sketching on a paper become the idea of a logo. You can make many 
sketches and scribble your ideas without worrying about any interference and distraction. There is no 
pressure of being perfect in sketching. This gives you the freedom of thought and the process of 
creating a logo design become much smoother. 

How to proceed with sketching branding design 

01. Know Your Brand 

https://www.designhill.com/logo-design/?utm_source=Organic_DhBlog_proceed_sketching_logo_design&utm_medium=interlinking&utm_campaign=proceed_sketching_logo_design&utm_term=logo_designs
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The first step to sketching is to know your client’s brand. Before you put pencil to paper, do some 

research about what product or service your client delivers to the customers. Who are the target 

consumers and what market the client wants to target? 

You should have some information about the consumers’ backgrounds. Find out if the consumers 

belong to the high-end sophisticated class or they are from middle class. What are their expectations 

from the brand? 

 

Know the brand’s mission as well. Talk to the client to find out how the company wants to project itself 

in the market. Write a brand mission in few clear stances that will serve you as a guide to create a 

significant brand design. 

02. Know The Key Branding Elements 

When sketching, you must be aware of the main branding elements. Your client’s business is different 

from the others. If it should compete hard, it has to be different. So, find out the key elements that can 

make your brand stand out. Then, make sketches based on those elements. 

 

For example, the inspiration behind the Yelp logo is pizza slices. Similarly, the inspiration for Zomato 

logo is a spoon. Both these company logos want the target consumer to think of food, which is the field 

of business in this case. These two elements are a key to branding these businesses. 

03. Take Help of Software 

There are some software’s available for getting sketching ideas. For example, The Noun Project can give 

you hundreds of icons that depict your choice of subject for sketching. 

https://www.designhill.com/tools/logo-maker?utm_source=Organic_DhBlog_proceed_sketching_logo_design&utm_medium=interlinking&utm_campaign=proceed_sketching_logo_design&utm_term=create_a_logo_design
https://www.designhill.com/tools/logo-maker?utm_source=Organic_DhBlog_proceed_sketching_logo_design&utm_medium=interlinking&utm_campaign=proceed_sketching_logo_design&utm_term=create_a_logo_design
https://www.designhill.com/logo-design/company-logos/


76 
 

 

So, if you search for food, the software displays several visual ways to depict food. Find out such 

software that you can use to have some idea of what your logo design sketch should look like. 

04. Draw Your Own Sketches 

After you have some insight of the business, its customers, and design elements needed, you can then 

start drawing sketches. Draw as many sketches as you can quickly. That is the trick, as your brain will 

deliver you many concepts if you do not break the chain of thought. So, do not worry about how the 

sketches are in terms of the quality. Just go on randomly making the drawings at a quick pace. 

 

Now that you have five to six drawings, take a look at them and see if they are catchy. If you are not 

satisfied, try some more sketches. The point here is to find out an attractive and unique sketch that has 

the potential of being a great branding design. You can then develop these sketches into desired 

branding or logo. 

05. Develop The Sketch 

The next step is to select one sketch and develop it into a professionally designed piece of work. Select 

the sketch that you think is nearer to expressing your client’s brand message and mission. One of the 

things to consider here is that the sketch is catchy and looks elegant. 

Once you have picked the sketch, it is now time to refine it. Give a shape to the sketch. Do not go to the 

computer just yet. Instead, sharpen the features of the sketch and see what extra can you add to it. 



77 
 

 

You should think of adding some more elements of shape, line, textures, patterns and other geometric 

aspects to make the drawing even more attractive and memorable. During this phase, you may come 

out with some more elements that you must add to it. Refine the sketch as much as you can. The idea 

here is to give the branding logo one big size. 

06. Tweak In Some Colours 

Now that you have developed a black and white drawing of the branding logo sketch, give it some 

colours. The matter of giving a logo sketch right colours is important. At the stage of colouring your 

sketches, you are actually experimenting with the colours. There is a wide range of colours and colour 

schemes to choose. 

However, which colour scheme will suit your logo depends on which colour will evoke an intended core 

emotion. This means that the colours you use will be the ones that can convey your brand message or 

build a brand identity. 

 

For example, if the logo is for a fast-food company, it would like to target young people as their 

customers. Therefore, the fast food logo can have red as its main colour. The red colour will evoke the 

feelings of passion, love, aggressiveness, and youthfulness. The very emotions will be part of your brand 

message. 

So, pick the colours and hues perfectly by experimenting with many shades. Compare many colour 

combinations to find out which one will suit better to the company’s brand personality. Another thing 

to consider here is that the logo colours should be more or less matching to the colours in the client’s 

website design and other marketing materials. So, go through the branding colours of the client’s 

business and try to incorporate them in your sketches. 

07. Give Finishing Touches 

https://www.designhill.com/logo-design/food-drink-logos/
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Now that you have filled colors in your logo, it’s time to give the logo its finishing touch. At this stage, 

you should be able to give the logo design proper shape. If the logo is looking disproportionate, correct 

its measure. 

 

You will be doing this correction on the drawing board. But at the sketching stage itself, you can give it a 

sense of proportion. There may be some elements who unnecessarily dominate the design. Reduce 

their influence over the design. Know which of the elements should be the main attraction and which 

should be eliminated. 

So, these are the key points to consider when sketching your logo design. If you are a graphic designer 

and trying to win a logo design contest on crowdsourcing sites such as Design hill, consider these tips 

also. This marketplace is a leading site for graphic designers and business owners. 

Designers should start making sketches to arrive at a right logo design to win the design contest. Design 

hill has 100 % Money Back Policy so that the client’s investment in creating a logo is safe and secure. 

1.2. Colour scheme  

Your colour palette is a vital part of your brand's identity, and choosing the right logo colours entails 

much more than selecting your favourite colours. Colours have different meanings that convey an array 

of emotions and concepts and have the ability to influence our behaviour and decision-making. 

With a broad spectrum of colours to choose from, selecting your brand colour palette might sound like 

a daunting task. 

This guide will walk you through understanding the difference between each of the colours and how to 

choose the right colour for your brand. 

How to choose the right colour for your branding 

1. Know how many colours to have in your brand colour scheme 

2. Use the colour wheel to find colours that match 

3. Understand the link between brand personality and colour palette 

4. Discover the best brand colours based on your industry 

5. Know your brand colour codes 

6. Final thoughts 

1. Know how many colours to have in your brand colour scheme 

Did you know that research has shown that people make a subconscious judgment about a product 

within just 90 seconds of looking at it, with up to 90% of their assessment being based on colour alone? 

https://www.designhill.com/contests
https://www.fiverr.com/resources/guides/graphic-design/how-to-choose-colors-for-brand#1-know-how-many-colors-to-have-in-your-brand-color-scheme
https://www.fiverr.com/resources/guides/graphic-design/how-to-choose-colors-for-brand#2-use-the-color-wheel-to-find-colors-that-match-
https://www.fiverr.com/resources/guides/graphic-design/how-to-choose-colors-for-brand#3-understand-the-link-between-brand-personality-and-color-palette-
https://www.fiverr.com/resources/guides/graphic-design/how-to-choose-colors-for-brand#4-discover-the-best-brand-colors-based-on-your-industry
https://www.fiverr.com/resources/guides/graphic-design/how-to-choose-colors-for-brand#5-know-your-brand-color-codes
https://www.fiverr.com/resources/guides/graphic-design/how-to-choose-colors-for-brand#final-thoughts
https://www.tourolaw.edu/lawreview/uploads/pdfs/27_2/9.pdf
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What's more, colour can increase brand recognition by 80%. If you want to encourage a strong 

emotional connection with your customers, your brand colours provide the shortcut straight to your 

target audience's hearts. 

When you first start considering colours, you may wonder how many you need to define your brand. In 

examining some of the world's most popular brand colour schemes, it's evident that many highly 

effective palettes contain three key elements: 

Base colour: This is the brand's most dominant colour. Therefore, it should reflect your most important 

brand personality trait while appealing to your target audience. 

Accent colour: The second-most important brand colour, after the base colour. Not only should it 

convey another trait of your brand, but it must also pair well with your base colour and appeal to your 

audience. 

Neutral colour: Refers to a colour that doesn't demand attention but ties your colour palette together 

in an understated way. Think of colours you'd typically use in the background, such as shades of white, 

beige, or grey. 

The brand's base colour is a zesty orange, conveying joy, enthusiasm, and fun. The accent colour is bold 

magenta, which is playful and stimulating. 

Together, these colours represent the brand's colourful sprinkled donuts and fun-loving personality. Its 

primary neutral colour is chocolate brown, which compliments the two louder shades and conveys the 

brand's sweet and down-to-earth identity. 

2. Use the colour wheel to find colours that match 

On your journey to creating a brand colour palette, you're likely to come across numerous terms 

relating to colour theory and design. One essential concept to understand is the colour wheel, which is a 

visual representation of the relationships between primary colours and other shades. 
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The Fundamental aspects of the colour wheel include: 

The primary colors are red, blue, and yellow. These colours cannot be mixed from other colors. 

Secondary colors, including green, orange, and purple. These colors are created when primary colors 

are mixed together. 

Tertiary colors are those made by mixing primary and secondary colors together, such as aqua or violet. 

The colors wheel can also be split down the middle to represent the two distinct color temperatures: 

Cool colors include blues, greens, and purples. These are associated with cooler seasons, including 

winter and spring, as well as feelings of calm and serenity. 

Warm colors include reds, oranges, and yellows. These are associated with warmer seasons, including 

summer and fall, as well as feelings of energy, action, and vitality. 

Looking at the color wheel, we can also determine three key color schemes: 

Complementary colors refer to two colors that are opposite one another. 

Analogous colors refer to three colors that sit directly next to each other. 

Triadic colors refer to three colors that are evenly spaced around the color wheel 

How does this information help you select your brand colors? An intelligent way to put this knowledge 

to work is to think about brands you know. 
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Best Buy is an excellent example of a brand that uses a complementary color scheme. The dynamic blue 

and yellow are opposites on the color wheel and work together to make Best Buy's logo stand out. 

 

With its green-and-yellow sun-shaped logo, company BP is a prime example of how to make an 

analogous color scheme work for a corporate brand. The colors convey both energy and nature to give 

viewers quick insight into BP's core purpose. 

 

What about a triadic color scheme? FedEx uses purple and orange, two colors evenly spaced on the 

color wheel, for its primary logo. The quirky purple is a departure from the staid brown of its chief 

competitor, UPS, and the orange conveys energy and momentum. 

3. Understand the link between brand personality and colour palette 

According to insights published in the Journal of Consumer Research, people prefer brands that "fit" 

well into their lives, and favorite brands often become part of people's identities. Color is one tool that 

marketers can use to convey their brand's core message and purpose. 

To truly narrow down your palette, you should begin by paying close attention to who you are as a 

brand and the personality you convey to your target audiences. 

A company with a fun brand personality, for example, might choose a vibrant and energetic color 

palette such as pink and yellow. A more serious and mature brand personality, on the other hand, 

should be represented with colors like blue and gray. 

https://academic.oup.com/jcr/article/46/5/995/5637759
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• Colour psychology in relationship to human behaviours and ability 

Red: action, strength, energy, and passion 

Orange: emotion, youth, optimism, and enthusiasm 

Yellow: happiness, optimism, positivity, and intellect 

Green: harmony, safety, growth, and health 

Blue: security, trust, loyalty, and responsibility 

Purple: spirituality, mystery, royalty, and imagination 

Pink: compassion, love, femininity, and playfulness 

Black: protection, power, elegance, and sophistication 

White: cleanliness, purity, innocence, and perfection 

Gray: compromise, neutrality, control, and practicality 

Brown: reliability, stability, honesty, and comfort 

Gold: success, triumph, luxury, and abundance 

Silver: femininity, fluidity, sensitivity, and mystery 

• Keep culture in mind when choosing colours 



83 
 

Culture also plays a significant role in color associations and preferences. White is associated with joy 

and purity in Western countries, yet it's associated with death in many Asian countries, for example. Do 

your research beforehand to ensure your brand colors don't have negative connotations in countries 

where your target audience is based. 

4. Discover the best brand colours based on your industry 

Did you know certain colors are more suited to specific industries due to the relevant messages and 

emotions they convey? Understanding your industry is an essential step in choosing your brand colors. 

Red 

Red is a common choice in the food, technology, automotive, and agricultural industries. Some famous 

examples of brands that utilize the color red in their logo design and brand palette include Kellogg's, 

Nintendo, and Ferrari. 

Orange 

Orange is a popular brand color among companies in both the technology and health care sectors. 

Brands including Firefox, Amazon, and GSK Consumer Healthcare are just three examples of companies 

within these fields that use orange as a brand color. 

Yellow 

Yellow is a common color selection for brands specializing in energy, food, or household goods. 

McDonald's, IKEA, and Shell are three brands that famously use yellow in their color palette. 

Green 

Green is a prevalent brand color within the energy, finance, food, household, and technology industries. 

BP, Starbucks, and Android are three famous brands that include green in their color palette. 

Blue 

Blue is one of the most prevalent colors within brand color schemes, particularly those within fields 

relating to energy, finance, airlines, technology, healthcare, and agriculture. Twitter, NASA, and Oral B 

are three such examples. 

Purple 

Purple is popular within the finance, technology, and healthcare sectors. Three examples of companies 

using purple within their brand colors are Yahoo!, New York University, and Starlight Children's 

Foundation. 

Pink 

Pink is a dominant brand color within the technology, beauty, health, toys, and food-related industries. 

Taco Bell, Barbie, and Victoria's Secret are just three brands that use pink. 

Black 

You'll often see companies in the fashion, technology, and automotive space utilizing black in their 

brand colors. Examples include Nike, Sony, and Mercedes. 

White 

https://www.fiverr.com/resources/guides/graphic-design/color-meanings?context_referrer=education_hub_guide&source_type=link&text=specific%20industries
https://www.fiverr.com/categories/graphics-design/creative-logo-design?context_referrer=education_hub_guide&source_type=link&text=logo%20design


84 
 

Although it's a neutral color, white can also serve as a dominant brand color, particularly among fashion 

and healthcare brands. Adidas, Chanel, and GE Healthcare are three examples. 

Gray 

Gray is a common brand color in the automotive, technology, petrochemical, and interior design 

industries. Companies including Wikipedia, Honda, and Nissan use gray within their color palette. 

Brown 

When it comes to the color brown, you'll most often find it used for brands in the fashion, 

automotive/transport, and agricultural industries. Louis Vuitton, UPS, and Cotton are three examples. 

Gold 

Gold is a popular brand color for companies in fields such as fashion, gourmet food, entertainment, and 

automotive. Warner Bros. Pictures, Guess, and Lindt all use gold within their color palette. 

Silver 

Silver is a versatile brand color typically featured within fields relating to the internet, technology, 

watchmaking, electronics, news media, and video games. Disney, Bvlgari, and Star Wars are three 

brands that may come to mind. 

5. Know your brand colour codes 

Since color is such an important part of your branding, you'll want to ensure your chosen palette 

remains consistent across desktop, mobile, and print. The way you do this is by knowing each of your 

brand colors in their relevant color codes: PMS, CMYK, RGB, and HEX. 

https://htmlcolorcodes.com/


85 
 

 

PMS (Pantone Matching System): patented, standardized color inks manufactured by the Pantone 

Corporation 
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CMYK: a printing technique that uses a mixture of small transparent dots in four ink colors: cyan, 

magenta, yellow, and black 

RGB: a method of displaying colors on-screen using red, green, and blue color combinations. RGB is 

exclusive to digital applications 

HEX (hexadecimal color): a six-digit number and letter combination determined by the proportions of 

red, green, and blue (RGB) 

6.Final thoughts 

Now that you know how to choose the best colors for your brand, you're ready to finalize your palette 

and put it to successful use within your business. 

Your business color palette allows you to communicate what your brand is about while cultivating a 

strong emotional connection with your customers. Since most brand purchasing decisions rely on 

emotions, there's no denying the significance color plays in the success of your brand. 

As the saying goes, "first impressions count." The first thing a consumer will see about your business is 

your brand colors—often in the form of your logo. 

1.3. Designing interior branding using CAD 

CAD is also sometimes called “computer-aided design and drafting” (CADD). Using computer-based 

software to assist in design processes is known as computer-aided design. Various kinds of engineers 

and designers regularly utilize CAD software. Two-dimensional (2-D) drawings and three-dimensional (3-

D) models can both be produced using CAD software. 

Produce final concept using photoshop CAD software 

Let take look on how to create a logo brand using photoshop software step by step.  

How to make a logo in Photoshop 

 

 

If you're wondering how to make a logo in Photoshop, we should first make an important clarification. 

Photoshop was not created to design logos. While Photoshop is certainly about a lot more than just 

photos, and it offers a huge suite of tools for designers and illustrators, there's a reason why it isn't 

usually used to make logos. 

In the guide below, you will find a basic option for how to make a logo in Photoshop using simple shape 
tools, gradients and text options. Of course, you'll want to make a logo in Photoshop that reflects your 

https://www.inc.com/logan-chierotti/harvard-professor-says-95-of-purchasing-decisions-are-subconscious.html
https://www.inc.com/logan-chierotti/harvard-professor-says-95-of-purchasing-decisions-are-subconscious.html
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brand, not the specific example that we're going to create for purposes of demonstration, but you can 
use the same concepts and tools to create your own branding design. 

01. Create a new canvas in Photoshop 

Open Photoshop and create a new document. I used a canvas size of 500px x 500px, but larger sizes 

would work just as well. You can change the canvas size at any point. Go to Edit > Preferences > Guides, 

grids to set a gridline every 50px. Then turn the grids on, in the canvas, by pressing cmd + ' (ctrl + ' in 

Windows) or View > Show > Grid in the Options bar. Make sure Snap to Grid is ticked on under View > 

Snap to. 

02. Draw a basic shape 

Select the Pen tool in the toolbar, or by pressing P, and make sure it’s set to Shape rather than Path in 

the box at the left of the Options bar. Use the pen to draw an arrowhead shape, starting at the centre-

point of the canvas and using grid-line intersections for your other points (if you're not familiar with the 

pen tool, note that to draw a straight line, you simply click and release where you want the points to be 

– don't hold down and try to draw a line as if it were a brush).  

Naming the layers isn't necessary for this project, but it can be very helpful in more complicated 

documents, where there are many layers. 

03. Duplicate and edit the shape 

Duplicate the layer, by pressing cmd + J (ctrl + J) and click on the new layer to select it. Use the Direct 

Selection tool, shortcut A, to click on the top-most point of the arrowhead, located at the centre of the 

canvas. Move this point down a few grid squares, holding the Shift key to keep it locked on the y-axis. 

04. Add colour with a gradient 

Create a new gradient in the Fill drop-down menu, to the left of the Options bar. In the gradient 

window, double click on the bottom sliders to bring up RGB options, where you can choose your 

colours; I went for a light and dark blue. Then apply this gradient to both objects, changing the gradient 

rotation so they oppose each other. If you can’t see the Fill options, it may be because you may have 

the Move tool selected, so switch to the Pen or Shape tool. 

05. Group and duplicate your layers 

Group the two layers by selecting them and pressing the group button, which looks like a little folder, 

located at the bottom of the Layers tab. This prevents the Layers tab from becoming messy and makes 

it easier to handle the two layers together.  

Duplicate this group (right click and select Duplicate Group), and then use the Free Transform function 

to rotate the new group ninety-degrees, holding down the Shift key to rotate in fifteen-degree 

increments. You can access Free Transform using cmd + T or under Edit > Free Transform. Now move 

the second group up, until it reflects the original shape, using the centre of the canvas as a line of 

symmetry. Repeat to create the shape shown above. 

06. Transform the shapes 

Nudge each shape up or down one grid square, away from the centre point, using Shift + cursor key. 

07. Group, duplicate, repeat 
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Using the same method from step #5 to group the layers together, duplicate the group and rotate by 

45-degrees. The new shape should resemble a sort of crosshair shape. 

08. Draw a circle with the shape tool 

Cycle through Shape tools until you find a circle, either by clicking-and-holding on the icon in the toolbar 

or pressing Shift + U. Click on the centre point of the canvas, holding Alt to draw a circle radiating from 

the centre, and Shift to keep the width and height proportional. If you make a mistake, you can undo or 

re-edit your shape using Free Transform. 

09. Draw a rectangle and align to the centre 

Cycle through the shape tools again, until you find the rectangle tool. Draw a white box across the 

graphic, above the other layers, making enough space for text. You can align this to the centre of the 

canvas by clicking on the rectangle layer and the bottom layer (which should be a white square, the 

same size as the canvas) and using align tools, either found under Layers > Align in the Menu Bar or the 

align buttons in the options bar.  

More advanced users could use this rectangle to subtract from the shapes below, using Layer > 

Combine shapes, but for now we will just stick to using it as a white block. 

10. Add your text 

Next up in our simple method of how to make a logo in Photoshop, we'll add some text. Draw a text box 

over the rectangle, by clicking on the T icon in the toolbar or pressing T, then dragging across the 

canvas. Type your text into the box and centre it, using the buttons in the Character tab. Use the align 

tool again to centre this to the canvas. 

11. Choose an appropriate typeface 

Choose a typeface that suits your brand. There are plenty of free fonts out there, but it is crucial to pick 

one that you have permission to use – see our pick of the best free fonts for some ideas. Since this logo 

may appear across many of your assets, you should make sure you don't use an illegally downloaded 

typeface – you may be surprised how quickly you might hear from the owner. Play around with size and 

colour until you like what you see. 

12. Adjust your kerning 

Kern the text. This means adjusting the horizontal spacing between individual letters, maximising the 

word’s readability. You can do this under the Type tab, marked with V | A, or by clicking between the 

letters and pressing alt + left or alt + right.  

13. Add final details and export 

Finally, to finish making your logo in Photoshop, make any final adjustments you need to give it that 

special something. For the main image at the top of this page, we've added two smaller bars above and 

below the text, coloured with the same gradient. We also added a background, shadow and reflection, 

using similar techniques to the other steps, as well as using layer masks to add fade.  

When you're happy, save the image out in whatever format you require, for example RGB jpg for web 

format. It's a good idea to save it as a psd file so that you can return to it and make changes in the 

future. 

https://www.creativebloq.com/graphic-design-tips/best-free-fonts-for-designers-1233380
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Theoretical learning Activity  

• Ask trainees to outline steps of developing interior branding drawings 

Points to Remember (Take home message) 

 
 
 

 

Learning outcome 3.2: formative assessment 

Written assessment 

1. Outline steps of developing interior branding drawings 
2. Explain the term color scheme 
3. Explain types of color schemes exist 
4. What is a colors code used in interior design 

Learning outcome 3.3 Develop presentation of the project. 

 

Duration: 10 hrs 

Learning outcome 3.3 objectives:   
By the end of the learning outcome, the trainees will be able to: 

1. Developing a project presentation mock-up 

Resources 

Equipment  Tools Materials  

- Books 
- Computers 

- Marker pen - Internet 
-Banners 

• Steps of developing interior branding drawings 

• Procedures to create colors scheme to be used in design 
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- projector 
- Board   
- Flip chart 

 

 

 

 

 

 

 

 

-Sample of interior 
branding 

Advance preparation: 

• Install CAD software into computers and ask trainees to design any 
interior branding they prefer according to what they have sketched 
before 

 

 

 

Indicative content 1 Steps of developing a mock-up 
 

What is a mock-up? 

A mock-up is a staged photo that you can overlay designs onto. Mock-ups showcase your designs in a 

real-life setting but you don’t have to create the real-life setting yourself.  They are useful if you need to 

create “scenes” containing your artwork. They can also be used for branding or to create promotional 

photos. 

Mockups gives stakeholders in the page the ability to see what that page will look like while making 

suggestions for changes in layout, color, images, styles, and more. If you wonder what a page would 

look like using a secondary color, you can test how that will appear by making a second version of the 

mock-up. Similarly, if you want to make a change like adding a header while centering an image, your 

mockup can let the team see how that potential change might look. 

If you create artwork such as drawings, paintings or hand lettering using paper and pen/markers, the 

first step would be to either photograph your artwork or scan it into your computer.  

1. Open up the mock-up in Photoshop 
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2. Click File>Place>Embedded and navigate to the file on your computer. Hit “Open”. Your file 
will show up as a new layer. Hit “Enter” to place the file. 

 

3.  Resize/rotate/move your file as needed. The easiest way to do this is to select your layer in 
the layer panel and then click and drag the corners to resize/rotate. Move your file by clicking 
on the “Move” tool (upper left side) and then click and drag your file. 
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4. Centre your file over the area of the mock up that is designated for your artwork. In this case, 
it is the white piece of paper. If your image looks good, you can go ahead and save it. 
However, sometimes things don’t line up quite right after you resize and rotate like as shown 
below. 

 

Advanced technique: clipping mask  

If your artwork is not lining up exactly, you can use a clipping mask and/or layer masks to make it look 
correct on a mockup.  Here are the steps to use a clipping mask: 

1. Follow steps 1-3, above. 
2. Use the “Move” tool to move your artwork to the side. 
3. Using the “Rectangle” Tool, draw a rectangle (on a separate layer) over the spot where you 

want your artwork to be placed. Resize the rectangle to match the opening exactly. 
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4. Move your artwork back to its original place so it overlays the rectangle that you just drew. 
Make sure the rectangle layer is below your artwork layer in the layer panel. Select the 
artwork layer in the layer panel and hit “LAYER>CREATE CLIPPING MASK” 

 

You can see that the artwork now takes the shape of the rectangle and anything outside the 
rectangle has been “clipped”. If you are satisfied with how your design looks, you can save it 
and be done. But in this case, there is still a bit of overlap between the artwork and the paint 
tray that I want to take care of. 
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Advanced technique: layer mask  

To fix the spot where the artwork overlays the paint tray, create a layer mask. A layer mask is 
a non-destructive form of editing. Create the layer mask by clicking on the icon under the 
layer panel that looks like a rectangle with a hole in it.  

 

The layer mask will show up as a white box next to the selected layer as shown above. Make 
sure that the layer mask is next to the rectangle layer. You can drag the layer mask up and 
down in the layer panel to move it. 
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Now all you need to do is use the paintbrush tool to “paint” on the portion of the image that 
you want to disappear. In this case, you will paint on the portion of the artwork that is 
overlaying onto the paint tray.  Set the paintbrush color to black and make sure that the layer 
mask is selected in the layer panel. Then just paint over the area and the background will be 
revealed. If you mess up, all you need to do is “paint” over the area again using white and the 
artwork layer reappears. You aren’t deleting/erasing anything, you are just masking the layers 
to reveal the background layer. 

 

And there you go! Your artwork is now displayed beautifully and you can use the images in either an 

online shop, your website or wherever else you want to display them. 

Print photos in photoshop 
1. Do one of the following in Photoshop Elements: 

  
o To print an already open photo, choose File > Print. 

o Open a photo in Photoshop Elements and choose File > Print. 

o Select photos in the Photo Bin ( ). Use Ctrl-click to select multiple photos from the Photo 
Bin and choose File > Print. 

2. In the Print dialog box, specify the desired options. For details, see Print dialog box options. 

3. Click Print. 

Print a contact sheet in photoshop 

A contact sheet enables you to preview a group of images by displaying thumbnail images on a single 
page.  

1. Do one of the following: 

o Choose Create > Photo Print > Contact Sheet. It opens Elements Organizer workspace. 

o Choose File > Print and select Contact Sheet as type of print in the Print dialog box. 

https://helpx.adobe.com/photoshop-elements/using/printing-photos.html#print_dialog_box_options
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2. In the Print dialog box, specify the desired options. For details, see Print dialog box options. 

3. Click Print. 

Print a picture package 

A picture package enables you to place multiple copies of one or more photos on a single page. 

1. Do one of the following: 

o Choose Create > Photo Print > Contact Sheet. It opens Elements Organizer workspace. 

o Choose File > Print and select Picture Package as type of print in the Print dialog box. 

2. In the Print dialog box, specify the desired options. For details, see Print dialog box options. 

3. Click Print. 

Print dialog box options 

In the Print dialog box, you preview the print and set the following options: 

Select Printer 

Select a printer from the drop-down list. 

You can print photos to PDF as well. To do that, you must install Adobe Acrobat on your system. 

Select Paper Size 

Select the desired size of the paper for printing photos from the drop-down list. 

Orientation 

Specify the orientation of the page as portrait or landscape. 

Select Print Size 

Select a print size for the photo. Select Custom to specify the dimensions of the photo. For more details, 
see Scale photos. 

Crop To Fit 

Select this option to fit the individual image to the specified print layout. The image is scaled and, if 
necessary, cropped to match the aspect ratio of the print layout. Deselect this option if you don’t want 
your photos cropped. 

Print Copies 

Select or enter a number in the text box to specify the number of copies of each page that you want to 
print. 

https://helpx.adobe.com/photoshop-elements/using/printing-photos.html#print_dialog_box_options
https://helpx.adobe.com/photoshop-elements/using/printing-photos.html#print_dialog_box_options
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In Windows, you can modify the following print settings: 

• Click Change Settings under Printer Settings to specify the printer, paper type, paper tray, paper 
size, print quality. Click Advanced Settings to open the printer driver options. 

• Choose one of the following options from the Select Type Of Print drop-down list: 

o Individual Prints: Print individual photos 

o Picture Package: Arrange photos in various layouts and frames (borders for individual 
photos). Selecting this option opens Element Organizer for further process. For details, 
see Printing photos. 

o Contact Sheet: Automatically arrange selected photos in a single-column or multicolumn 
layout. Selecting this option opens Element Organizer for further process. For details, 
see Printing photos. 

Add photos using the Print dialog box 

In the Print dialog box, you can add multiple photos to a print job. 

Do the following: 

1. In the Print dialog box, click the Add button ( ). 

2. In the Add Photos dialog box, select one of the following: 

Photos Currently in Browser: Displays photos currently visible in the Media Browser. 

Entire Catalogue: Displays all photos in your catalogue. 
  

Album: Displays photos from a specific album. Use the menu to select an album. 
  

Keyword Tag: Displays photos with a specific tag. Use the menu to select a tag. 

https://helpx.adobe.com/elements-organizer/using/printing-photos.html
https://helpx.adobe.com/elements-organizer/using/printing-photos.html
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Only Show Photos with Ratings: Displays only photos marked with the Favourites tag. 
  

Also Show Hidden Photos: Displays photos marked as hidden. 

3. Click one or more thumbnails, or click Select All, and then click Add Selected Photos. 

4. Click Done. 

More options for printing 

When you click More Options in the Print dialog box, the following options are displayed: 

PRINTING CHOICES 

Enables you to specify the following settings: 

Photo Details 

You can print the date, caption, and filename by selecting the following options: 

• Show Date 

• Show Caption 

• Show File Name 

Border 

You can specify the following details for the border: 

• Thickness in inches, mm, or points. 

• Colour of the border 

• Background colour 

Some printers have the inverting images option. If so, ensure that you use either your printer driver 
settings or the Invert image option to invert images. Selecting both the options horizontally flips the 
image twice. 

Trim Guidelines 

Select Print Crop Marks (guidelines on all four edges of the photo) to make it easier to trim a photo. 
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Printing choices 

CUSTOM PRINT SIZE 

Enables you to specify the following settings: 

Print Size 

You can specify the width and height in inches, centimeters, and millimeters. Select Scale to fit Media to 
scale the image to fit on the page. 

 

Specify the dimensions of the photo for printing 

COLOR MANAGEMENT 

Displays the colour profile of the image. Image Space shows the colour space embedded in your photo 
file. (The print preview in the Print dialog box is not colour managed and doesn’t update as you choose 
a profile.) You can change the profile for printing from the following options: 

Colour Handling 

You can choose to have either your printer or Photoshop Elements manage colours. 

Printer Profile 

Sets a custom printer profile to convert image colours to the printer’s colour space, or turns off colour 
conversion. If you have an ICC profile for your printer and paper combination, choose it from the menu. 
Make sure that you turn off the printer driver’s colour management. 

Rendering Intent 

Specifies how colours are translated from the image’s source colour space when certain colours are not 
available in the print space. 
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Colour management options available for printing photos 

Page setup options for printing 

When you click Page Setup in the Print dialog box, the following options are displayed: 

• Printer Add a printer or specify the preferences for your printer. 

• Copies Specify the number of copies you want to print. 

• Pages Choose one of the following options: Single, Range, and All. Specify the page number or 
the page range. 

 
Click show details to specify additional options 

Presets Choose default settings, last used settings, or saved presets. 

Layout 

• Pages Per Sheet Specify the number of pages you want to print on one sheet of paper. 

• Layout Direction Select the layout of the pages that you want to print on one sheet of paper. 

• Border Select a border from the drop-down list. 

• Two-Sided Choose On to print on both sides of the sheet. 

• Reverse Page Orientation Select this option to change the orientation of the page for printing. 
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• Flip Horizontally Select this option to flip the page being printed horizontally. 

 

Paper Handling 

• Collate Pages Select this option to print pages together. 

• Pages To Print Choose the desired option to print all pages, even pages, or odd pages. 

• Page Order Choose the page order for printing: Automatic, Normal, or Reverse. 

• Scale To Fit Paper Size Select the option to fit the page to the paper size being used for printing 
photos. 

• Destination Paper Size Select the paper size for printing photos. 

• Scale Down Only Select this option to scale down the page to fit the paper size. 

 

To save your settings, do one of the following: 

• Click Save in the Page Setup dialog box. 

• Choose Save Current Settings as Preset in the Presets drop-down list. 

Position and scale photos 

You can adjust the position and scale of an image using options in the Print dialog box. The shaded 
border at the edge of the paper represents the margins of the selected paper; the printable area is 
white. The blue border at the edge of the photo is the Photoholder; it is not printed with the image. 

Scaling an image in the Print dialog box changes the size and resolution of the printed image only. For 
example, if you scale a 72-ppi image to 50% in the Print dialog box, the image will print at 144 ppi; 
however, the document size settings in the Image Size dialog box will not change. 
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Position a photo on the paper 
1. Choose File > Print. 

2. Under the Position settings in the Print dialog, do one of the following: 

o To center the image in the printable area, select Center Image. 

o To position the image numerically, deselect Center Image, and then enter values 
for Top and Left. 

o Deselect Center Image, and drag the placeholder or the image in the preview area. 

 
Position settings 

Rotate an image 
1. Choose File > Print. 

2. In the Print dialog box, do one of the following to rotate the Photoholder or the image: 

o Click the Rotate Image buttons to rotate the Photoholder. 

o Check Image Only to rotate just the image. 

Scale the print size of an image 
1. Choose File > Print. 

2. Click More Options in the Print dialog. 

3. Select Custom Print Size. Then, do one of the following: 

o Select Scale To Fit Media to scale the image to fit on the page. 

o Specify the units of measurement from the Units menu and enter values 
for Height and Width to rescale the image numerically. The dimensions are constrained, 
meaning that changing one dimension proportionately changes the other dimension. 

You can Zoom In or Out of the image using the slider in the Print dialog box. 

 
Adjust the slider to zoom the image within the photoholder 

Print multilayer images 

If your image (PSD or TIFF) is multi-layered, use the Layers panel to temporarily hide the layers from 
view and prevent them from printing. 

1. In Expert mode, open a multilayer image. 

2. In the Layers panel, click the Eye icon   to make a layer invisible. 

3. When only the layers you want to print are visible, choose File > Print. The Print dialog box 
opens with only the visible layers showing in the thumbnail preview. 

4. Set your printing options and click Print. 
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Theoretical learning Activity  

• Ask trainees individually to outlining steps of developing a mockup 

Practical learning Activity  

Ask trainee to design a branding mockup in computer using adobe Photoshop software 

Points to Remember (Take home message) 

 
 

 

Learning outcome 1.1: formative assessment 

Written assessment 

1. Explain the term mock-up used in interior branding design 
2. What the steps of developing interior branding mock-up? 
3. How to make a printout of mock-up of the final interior branding design? 

Practical assessment 

HABINEZA has contracted to make a final mock-up design that has to be presented to the 
AIKO design compony that want to make interior branding of a new hotel located in 
GASABO district. the illustration images, logo, colors codes and colors scheme will be 
given by the client. The mock-up should be saved on A0 paper format. 

 

 

 

 

 

 

 

✓ Steps of developing mock-up design 

✓ Procedure to print out a mock-up design 
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LEARNING UNIT 4: IMPLEMENT INTERIOR BRANDING DESIGN   

 

Picture/s reflecting the Learning unit 4 

 

 

 

 

 

                                              

STRUCTURE OF LEARNING UNIT        

Learning outcomes: 

4.1 Wear PPE 
4.2 Mount interior branding components 
4.3 Clean the workplace 
 

 

Learning outcome 4.1 Wear PPE 
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Duration: 5 hrs 

Learning outcome 4.1 objectives:   
By the end of the learning outcome, the trainees will be able to: 

1. Identify types of PPE 

2. Understand the function of PPE 

3. Understand the use of PPE 

 

Resources 

Equipment  Tools Materials  

- Books 
- Computers 
- projector 
- Board   
- Flip chart 

- Marker pen 
 

 

 

 

- Internet 
-Banners 
 

Advance preparation: 

. Take learners to workshop and show them the different types of PPE 

. Use tutorials to show to the learners the use of PPE 

 

 

 

 

Indicative content 1 Types of PPE 
 

 
What is PPE? 

PPE (Personal protective equipment) can include items such as safety helmets, gloves, eye protection, 

hazmat suits, high-visibility clothing, safety footwear, safety harnesses, ear plugs, ear defenders and 

respiratory protective equipment (RPE). In appropriate situations disposable PPE may be provided; eg 

https://www.shponline.co.uk/hazmat-suits-your-complete-buyers-guide/?cid=nav
https://www.shponline.co.uk/safety-boots-footwear-a-buyers-guide/?cid=nav
https://www.shponline.co.uk/ear-plugs-at-work-a-buyers-guide/?cid=nav
https://www.shponline.co.uk/hearing-protection-a-how-to-guide-for-those-choosing-ear-defenders/?cid=nav
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single-use coveralls. Employers have duties concerning the provision and use of personal protective 

equipment at work. 

Types of PPE and standard operation procedures 

Various types of PPE are available for use in the workplace. The Health and Safety Executive provides 

guidance and general information about types of PPE used in industry, but it doesn’t cover specialised 

and less-used items. 

Detailed information should be obtained from suppliers on these more specialised items. Potential 

users should be involved in the selection of equipment they will be expected to wear and if possible 

more than one model should be made available to them. 

The different types of PPE include: 

• Head and scalp protection; 

• Respiratory protection; 

• Eye protection; 

• Hearing protection; 

• Hand and arm protection; 

• Foot and leg protection; 

• Body protection; 

• Height and access protection. 

1. Head protection using helmet 

There are five primary purposes of head protection, to protect: 

• The head in falls; 

• Against falling objects, impact with fixed objects, or wielded weapons; 

• The head by offering thermal insulation; 

• Against entanglement and laceration to the head; 

• Against scalping/entanglement particularly on machinery where injuries are still numerous. Hair-

nets and caps are also used for hygiene reasons. 

All forms of head and scalp protection must be suitable, correctly fitted and have an easily adjustable 

headband, nape and chin strap where appropriate. The relevant standards are BS EN 397 and BS EN 

14052. 

 

2. Eye protection using goggles 

PPE for the eyes is intended to provide protection against impact, cuts, splashes, mists and sprays. The 

relevant standards are BS 7028 (Guide to Selection of Eye Protection for Industrial and Other Uses) and 

BS EN 166 (Specification for Eye Protectors). 

https://www.shponline.co.uk/health-safety-executive-hse/?cid=nav
https://www.shponline.co.uk/hearing-protection-a-how-to-guide-for-those-choosing-ear-defenders/?cid=nav
https://www.shponline.co.uk/safety-boots-footwear-a-buyers-guide/?cid=nav
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All PPE must be regularly cleaned, but this is especially important in the case of eye protection as dirty 

lenses lead to poor vision and may contribute to accidents. 

Where lenses become scratched, pitted or cracked they should be replaced. 

Users who need to wear corrective lenses (glasses) should have this requirement accommodated in the 

provision of the PPE to them eg as protective over glasses where appropriate, or in the form of 

prescription lenses if necessary. Where they may be required to wear eye protection on a regular and 

prolonged basis then any goggles, safety-glasses etc should meet the user’s prescription requirements. 

 

3. Hearing protection using ear plugs 

Assessments carried out under the ‘Control of Noise at Work Regulations 2005’ will determine whether 

personal ear protectors are required in the workplace or not, and the noise attenuation required. The 

relevant standard for the ear protectors is BS EN 352 Part 1. 

In providing hearing protection, employers should select protectors which are suitable for the working 

environment and should consider how comfortable and hygienic they are. Like other PPE, hearing 

protection will need to be compatible with other PPE (eg hard hats, dust masks and eye protection) 

worn by workers. 

Employers may also wish to provide a range of protectors to allow employees to choose ones which suit 

them. 

Bearin mind that the theoretical attenuation is rarely achieved and it is therefore necessary to over-

specify the protection. When selecting hearing protection, use the detailed noise assessment to 

determine the attenuation required at High, Medium and Low frequencies and match this against 

suitable products. Bear in mind that where ear plugs are used, training will be needed to ensure that 

they are used correctly. Where ear defenders are used it should be ensured that users do not use music 

headphones or buds simultaneously. For high noise environments, it may be appropriate to specify both 

plugs and defenders. 

 

4. Hand and arm protection using gloves 

Most work requires a degree of manual dexterity and consequently the hands are exposed to a wide 

range of hazards Risks include cuts, abrasions, heat, cold, chemical contamination, vibration, burns, 

infection, skin irritation and dermatitis. 

https://www.shponline.co.uk/hearing-protection-a-how-to-guide-for-those-choosing-ear-defenders/?cid=nav
https://www.shponline.co.uk/hearing-protection-a-how-to-guide-for-those-choosing-ear-defenders/?cid=nav


108 
 

Before selecting hand and arm protection, the hierarchy of control measures must be followed. Gloves 

and gauntlets provide the main form of hand protection against a range of industrial hazards, but other 

forms of PPE such as mitts, wrist cuffs or armlets may also be used. 

In the case of manual handling where there may be a risk of piercing by abrasive, sharp or pointed 

objects, gloves should be provided where these hazards cannot otherwise be removed, isolated or 

reduced to an acceptable level. Such gloves are usually made from leather, chain mail, rubber, knitted 

Kevlar or stout canvas. However, gloves should not normally be worn where there is a risk of them 

being caught in machinery. 

Where chemical exposure is a hazard, and the risk extends to contact with the arms, gauntlets should 

be specified rather than gloves. 

BS EN 14328 is the standard for gloves and armguards protecting against cuts by powered knives while 

BS EN 407 contains the specifications for gloves intended to protect against thermal risk such as heat 

and/or fire. BS EN 374 Part 1 covers gloves for protection against chemicals and microorganisms. BS EN 

511 covers gloves for protection against the cold. BS EN 388 covers the specification of gloves against 

mechanical hazards. 

 

5. Foot and leg protection using strong boots 

A wide range of safety footwear is available providing protection against many hazards to the feet or 

legs including crushing, slipping, piercing, temperatures, electricity, chemicals, cutting, and chopping. 

The relevant standard for safety footwear is BS EN ISO 20345. BS EN ISO 17249:2004 is the standard for 

chainsaw footwear. Depending on the hazard various PPE options may be appropriate including safety 

boots and shoes with protective toe caps and penetration-resistant mid-sole; gaiters; leggings; and 

spats. 

  

6. Body protection using overall 

The Regulations’ definition of PPE excludes ordinary working clothes and uniforms which have no 

specific protection for the wearer. However, body protection may be required for extended periods of 

work outdoors to protect against the weather, and to ensure high visibility during work where there is 

https://www.shponline.co.uk/safety-boots-footwear-a-buyers-guide/?cid=nav
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mixed vehicle and pedestrian traffic (see BS EN 471 + A1 ’High-visibility Warning Clothing for 

Professional Use’). 

PPE for the body may also be required where workers are exposed to extremes of temperature 

(whether outdoors or indoors), as well as chemical or metal splash, spray from pressure leaks or spray 

guns, impact or penetration, contaminated dust, excessive wear, entanglement of own clothing or the 

risk of drowning. 

 

When choosing body protection, the following factors should be considered: 

• Thermal comfort, for example, due to sweating; 

• Cost and practicality of cleaning; 

• Emergency procedures, such as buoyancy or the need to be identified or spotted in hazardous 

situations; 

• Level of hygiene control required; 

• Level of personal contamination; 

• Personal preference; 

• Restriction of movement; 

• Storage; 

• Temperature and humidity fluctuation; 

• Whether the worker is involved in a process that is wet or dry. 

7. Respiratory protection using masks 

This covers equipment ranging from breathing apparatus and positive pressure powered respirators 

through to protective hoods, close-fitting full-face respirators, half mask respirators and disposable 

face masks. It is always essential to select the correct equipment both for the risk and the individual 

and to ensure there is adequate training in its use. It should be noted that the only form of respiratory 

protection which is suitable for work in a confined space is breathing apparatus, as other forms of 

respiratory protection do not provide a source of air or oxygen. Face fit testing requirements apply to all 

close-fitting respirators. 

 

8.  Height and access protection using belts and lifting systems 

This range of protective equipment is very wide and includes body harnesses, fall-arrest systems, rescue 

lifting and lowering harnesses, energy absorbers and lanyards. 
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Such PPE is specialised and requires thorough training by competent persons, in user checks as well as 

correct use. 

 

Theoretical learning Activity  

• Brainstorm about the PPEs used in implementation of interior branding designs 

Practical learning Activity  

✓ Take trainees to workshop, give them PPEs and help them to wear them 
property according to standard 

Points to Remember (Take home message) 

 

 

 

Learning outcome 4.1: formative assessment 

Written assessment 

• Assessment instruments/tools  

Match the following PPEs with their used and applications 

PPEs  Uses and applications 
1. Helmet 
2. Mask 
3. Goggles 
4. Gloves 
5. Ear plugs 
6. Overall 
7. Safety boots 

g) Body protection 
h) Feet protection 
i) Eye protection 
j) Mouth protection 
k) Head protection 
l) Ear protection 
m) Hand protection 

Learning outcome 4.2 Mount interior branding design components 

✓ Types of interior branding PPEs used while implementing interior branding designs 

✓ Standard operation of procedures of using PPEs 
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Duration: 10 hrs 

Learning outcome 4.2 objectives:   
By the end of the learning outcome, the trainees will be able to: 

1. Install and mount interior branding design on wall 

2. Install and mount interior branding design on floor 

 

Resources 

Equipment  Tools Materials  

- Books 
- Computers 
- projector 
- Board   
- Flip chart 

- Marker pen 
 

 

 

 

 

 

 

 

- Internet 
-Banners 
 

Advance preparation: 

. Provide tools, equipment and materials on working place 

. provide teaching aids like projector and computer to show to the trainees 
steps of installing and mounting interior branding design 

 

 

 

Indicative content 1 Procedures of mounting branding designs on the wall 
and floor 
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During the installation of branding design, you may use the following procedures when mounting or 
installing branding design on wall using either drilling or sticking depend on the type of branding you 
have to apply. 
Drilling procedure 

This procedure is not applicable for all type of interior branding because some of them will use 
glue and other may have sticking ability like stickers. 
Let see how this procedure works. 

Step by step of mounting branding design using drilling procedure. 

b. Prepare the surface. 

During the preparation of the surface, you have to be sure that the surface is levelled and cleaned. The 
surface should not have gaps and being enlivened because this can cause imperfection during installation 

c. Measure the surface 

Take the measurement of the wall to be covered with branding design, in order to fit them on the surface 
of wall. You can take both horizontal and vertical measurement if the surface is rectangle or other else 
depend on the shape of your wall. 

d. Mark the surface. 

After measuring, the surface, you have to mark where you will drill holes for screw holders. Of Corse, you 
have to take a look on the branding layout you have made to avoid the provision of holes where the 
branding will not meet. 

e. Install screw holders or anchors. 

Anchors or screw holders have to be inserted into the drilled holes so that later can be used to hold the 
screw as the name implies. The screw holders should be inserted straitly for better fastening of screws. 

f. Fixing branding design 

Referring to layout, branding patterns and the holes created for screw attachments, you have to start at 
one side of the wall, place the first branding design and verify if it fit correctly and squeeze it to the wall 
by pressing with hand up and down to make sure the hole surface is well stretched. Continue successively 
till you cover the whole surface. 

g. Applying the final touch. 

This is the final step that consist of verifying if the installation looks evenly and to apply finishing if 
possible. You have also to verify if there isn’t excess of materials, they should be removed in order to 
remain with the desired view as it was provided by the designer. 

Sticking procedures 

As the name suggested, this procedure consist of using adhesives or stickers that are applied either on 
wall or floor. 

a. Preparation of the surface 

As we have described before, this step consists of checking if the surface is well levelled and well cleaned. 
During the preparation of the surface, you have to clean the surface using soap and water to be sure that 
no stain and dust remaining because they can reduce the strength of adhesive while applying branding 
on wall. 
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b. Apply glue on the surface 

Make sure the surface is well cleaned and dried to ensure that adhesive will stick properly on branding 
design 

c. Applying branding material  

Following the layout and patterns arrangement, apply branding design on either wall or floor and gently 
apply pressure to make sure branding materials and wall are bonded together. As usually start by one 
side, place the first branding material and continue following the provided layout till the whole surface is 
covered. 

d) Applying final touch 

Verify if the whole surface is well adhered and look evenly and check if there isn’t some imperfection or 
defects that are appearing. If the imperfection found correct them and check the vision design attended 
by the designer 

Theoretical learning Activity  

• Ask trainees to brainstorm about the procedures of mounting interior branding 
designs on both wall and floor 

Points to Remember (Take home message) 

 

 

Learning outcome 4.2: formative assessment 

Written assessment 

✓ Explain the procedures of mounting interior branding on wall and floor 

Learning outcome 4.3 clean of the workplace and storage of tools and equipment 

Duration: 10 hrs 

Learning outcome 4.3 objectives:   
By the end of the learning outcome, the trainees will be able to: 

1. Identify cleaning tools and equipment 

2. Identify cleaning materials 

3. understand cleaning methods 

4. understand storing methods 

✓ Procedures of mounting interior branding designs on both wall floor 
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Resources 

Equipment  Tools Materials  

- Books 
- Computers 
- projector 
- Board   
- Flip chart 

- Marker pen 
 

 

 

- Internet 
-Banners 
 

Advance preparation: 

. Provide tools, equipment and materials on working place 

. provide teaching aids like projector and computer to show to the trainees’ 
steps of installing and mounting interior branding design 

 

 

 

 

Indicative content 2 Cleaning tools and equipment  
 
The following is the list of tools used to clean working place 

Scrub brushes 

Scrub brush is a plastic brush with strong bristles and a handle with a 
rubber grip is enough to tackle most messes, including scrubbing a 
bathtub or sink. 
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Multi-purpose duster 

A-n extendable wand duster will serve you well once you notice the 

cobwebs gathering on the ceiling fan in the living room. Look for one 

that has a pivoting head and enough length to reach your ceiling height, 

and you’ll never have to worry about how to dust those tough-to-reach 

nooks and crannies. 

 

 

Sponges 

Sponge is another type of tool used to clean smooth surface 

like cleaning on metal, glasses and plastic to remove dust or 

greases. 

Heavy-duty sponges made of tough material for floor 

cleaning, ovens, and other surfaces that need a thorough 

scrubbing.  

 

 

Spray bottle 

 

When you’re trying to evenly distribute cleaning solutions, a regular water bottle 

won’t do the trick. Invest in a few glass spray bottles and you’ll always have an easy 

way to kick off a cleaning spree.  

 

 

 

Microfiber cleaning cloths 

Microfiber cloths are gentle on surfaces and ideal for picking up dust. 

They’re perfect for tidying up flatscreens or furniture, and they don’t 

leave streaks on mirrors or stainless steel.  

 

 

https://bungalow.com/articles/3-easy-ways-to-deep-clean-your-oven
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Broom and dustpan 

A broom and dustpan are essential for cleaning up spills, such as a 

knocked-over box of cereal on the kitchen floor, or sweeping up clippings 

on your patio. They’re also great for doing a little pre-cleaning before you 

vacuum. Opt for a pan with a rubber lip, which will grip the floor and allow 

you to neatly sweep all of the dust and debris into the pan. 

 

Mop 

A mop is your go-to tool for cleaning hard floor surfaces like 

tile, wood, or laminate and making them shine. You can buy one that 

has a handle you can fill with cleaning fluid, or a simple stick mop with 

a sponge head. Another option is a steam mop which uses hot water, 

and sometimes cleaning fluid, to clean floors. They also often have 

washable, reusable cleaning pads that you never have to wring out like 

a traditional mop head. 

 

Bucket 

 

If you do opt for that simple mop, you’re also going to need a bucket to hold 

your water and cleaning fluid. Buckets are also great for rinsing out sponges or 

rags, for soaking items, and for storing cleaning products when not in use. 

 

 

Gloves 

Cleaning fluids, hot water, and soap scums can be tough on your hands, so 

take care to protect them. Invest in a pair of sturdy rubber gloves that will 

help you tackle messier home cleaning tasks with confidence. Look for a set 

with a textured surface, so you can get a good grip on your brushes and 

other tools. 

 

Dustpan  

 

 

Dustpan is a cleaning tool commonly used to scoop the dirt and wastes on 
the floor. 
 

 

https://bungalow.com/articles/how-to-clean-hardwood-floors
https://bungalow.com/articles/how-to-clean-laminate-floors
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Water Hoses  

Water Hoses are hollow tubes designed to carry fluids from one location 
to another. Hoses are also sometimes called pipes (the word pipe 
usually refers to a rigid tube, whereas a hose is usually a flexible one), or 
more generally tubing. The shape of a hose is usually cylindrical (having 
a circular cross section). 

 

Cobwebber 

 

 

Cobwebber is used for reaching and sweeping of floor without as tool. 
It is also used to in stairwells, ceiling corners and other high areas. 

 

 

 

Cleaning Cloth  

 

Cleaning Cloth is used to wipe the cleaning tools and equipment. 
 

Paper towel  

 

Paper towel  is an absorbent textile made from paper instead of cloth used in 

drying hands, wiping windows, dusting and cleaning up spills. 

 

 

waste container  

 

 

A waste container is a container for temporarily storing refuse and waste. 
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Scrubbing Foam  

 

 

Scrubbing Foam is used to remove the contaminants of any tool and equipment. 

 

 

List of equipment used for cleaning working place 

Vacuum 

A vacuum cleaner is a device that uses an air pump to create a 

partial vacuum to suck up dust and dirt, usually from floors, 

and optionally from other surfaces as well. The dirt is 

collected by either a dust bag or a cyclone for later disposal. 

Vacuum cleaners, which are used in homes as well as in 

industry, exist in a variety of sizes and models— small battery-

operated hand-held devices, domestic central vacuum 

cleaners, huge stationary industrial appliances that can handle 

several hundred liters of dust before being emptied, and self-

propelled vacuum trucks for recovery of large spills or removal 

of contaminated soil. 

Floor buffer  
A floor buffer is an electrical appliance that is used to clean and maintain 
non-carpeted floors, such as hardwood, marble, tile or linoleum. It is also 
known as a floor polisher or floor burnisher. If it is a high speed floor buffer 
with a pad it rotates at over 1000 RPM (rotation per minute). It has a large, 
round scrubbing pad spinning in a circle in one direction which is powered 
by a small motor, usually directly over the center of the pad. 
 
 
 

 
Compressor 
 

 
 
Air compressors aren't designed for cleaning, but it's still common practice 
to clean the dust and debris from filters, machinery, workshop surfaces, 
clothes, and so forth using compressed air. Compressed air can harm you 
and the people around you when misused. 
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Theoretical learning Activity  

• Make a group of 4 learners and ask the to brainstorm about the equipment that 
can be used to clean the working place 

Points to Remember (Take home message) 

 

 

 

 

Indicative content 3 Cleaning materials and product  
 
 

Cleaning detergent is a surfactant or a mixture of surfactants with "cleaning 

properties in diluted solutions that is also used in cleaning purposes. 

 

 

 

 

Cleaning detergent is a surfactant or a mixture of surfactants with "cleaning 

properties in diluted solutions that is also used in cleaning purposes. 

 

 

 

 

 

Water is a liquid used for cleaning most of the tools and equipment. It is also known as 

the universal solvent. 

 

 

Baking soda otherwise known as bicarbonate of soda or sodium 

bicarbonate is used to deodorize refrigerators. 

 

 

✓ Cleaning equipment 
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Theoretical learning Activity  

• Ask trainees to write down different types of cleaning materials  

Points to Remember (Take home message) 

 
 

 

 

Indicative content 4 Cleaning Methods  
 

Cleaning with bases  

Common bases used in cleaning products include caustic soda, lye, and sodium silicate. While effective 

at removing oil based soils from the carpet, high pH cleaners are more corrosive and may damage 

sensitive fibers and dyes. 

Cleaning with acids  

Acids are used to remove mineral deposits, rust stains, and hard water deposits. They can remove 

discoloration from some metals, such as aluminum, brass, bronze, and copper. Some acids are effective 

both in cleaning and disinfecting surfaces. Acids range from very mild to very strong. 

Cleaning with solvents and degreasing  

Solvent cleaning is generally the first surface preparation method applied to the parts. Solvent cleaning 

removes release agents, such as silicone that may coat the part during molding, and any machine oil 

transferred to the part. Abrading surfaces coated with oil or grease drives the contaminants further into 

the parts, and chemical alteration of the surface is ineffective in the presence of contaminants.  

Chemical Cleaning 

Chemical cleaning is a method to derive surfaces and walls of equipment, pipelines, vessels, kettles and 

heat exchangers of unwanted contaminants. Chemical cleaning also means the purification, 

conditioning, treatment or disinfection of water. 

 

✓ Cleaning materials 

https://www.lenntech.com/water-purification-FAQ.htm
https://www.lenntech.com/water-treatment.htm
https://www.lenntech.com/disinfection.htm
https://www.lenntech.com/water-FAQ.htm
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Theoretical learning Activity  

• Make a group of three (3) trainees and ask them to discuss about the methods 
that can be used to clean working place 

Practical learning Activity  

✓ Disorder the equipment in workshop and ask trainees to store them in their 
appropriate place according to the method of storing  

 

Points to Remember (Take home message) 

 
 
 

 

 

 

Indicative content 5 Methods of storing tools and equipment  
 

The following are the methods used to organise the tools and equipment in workshop 

• Shelving: Shelves are an effective way to organize a space. Shelves can be custom built to fit the 

specific function of your space, and they can be stationary or modular, depending on your 

needs. Shelving units can be made of wood, metal, or plastic, and you can purchase them at 

your local hardware store and assemble them at home. Alternatively, if you’re handy with 

wood—or even metal—you can build your shelving from scratch or scrap. 

• Pegboards: One of the classic storage solutions is the wall-mounted pegboard. Made of a 

compressed fiber or wood, pegboards have evenly-spaced holes that can fit metal studs or 

hooks to support or hang your tools. Pegboards can help organize hand tools, like pliers, 

screwdrivers, hammers, and saws; power tools like drills, chargers, and electric saws; and 

woodworking tools like awls, planes, drill bits, saw blades, and chisels. 

✓ Cleaning methods:  

▪ cleaning with base 

▪ cleaning with acids 

▪ cleaning with solvent 

▪ Chemical cleaning 

 

https://www.masterclass.com/articles/how-to-make-a-diy-floating-shelf
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• Magnetic strips: Magnetic strips can be a great solution if you have the right equipment. Like 

magnetic strips in kitchens for storing knives, you can use magnetic strips to hang metallic tools 

containing enough iron to be magnetized. 

• Drawers: Drawers are another option that can work for the DIY home storage system. Sets of 

drawers come in many sizes—you can use tiny ones for screws and washers or bigger ones for 

cordless power tools. You can build drawers into a workbench, sit drawers on top of a 

workbench, or rest a set of drawers on the floor. You can also place drawers on casters so that 

you can move them throughout the workspace. 

• Storage bins: Bins tend to work better for long-term storage. If you have tools you use every 

once in a while or are too large and cumbersome to hang on a wall or rest on a narrow shelf, 

putting them in a bin might be the best choice. Storage containers like bins come in all shapes 

and sizes, many of them made from heavy-duty plastic. A toolbox is perhaps the best storage 

container and its portability is a significant asset. 

• Storage cabinets: Often, you will want to store tools close by in a protected place. Tool cabinets 

can offer your tools protection from dust and moisture, and they can also protect your space 

from substances and chemicals that are corrosive, flammable, or otherwise harmful. Tools 

involving paints or solvents, gasoline, or cleaning materials, are best kept in a secure metal 

cabinet. 

 

Theoretical learning Activity  

• Make a group of three (3) trainees and ask them to discuss about the methods 
that can be used to store equipment 

Practical learning Activity  

✓ Disorder the equipment in workshop and ask trainees to store them in their 
appropriate place according to the method of storing  

Points to Remember (Take home message) 

 

 

 

✓ Methods of storing equipment 

▪ Storing in cupboard 

▪ Storing in large bins 

▪ Storing in shelves 

▪ Storing in cabinets 
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Learning outcome 4.3: formative assessment 

Written assessment 

1. From the given list of cleaning tools and equipment, separate tools and equipment accordingly 
a) Bucket 
b) Broom 
c) Floor buffer 
d) Vacuum 
e) Spray bottle 
f) mop 
g) compressor 
h) sponge 
i) scribing foam 

2. Give at least 4 cleaning materials 
3. Explain the cleaning methods that can be used to clean working place 
4. Explain at least 3 methods that can be used to store equipment 

Practical assessment 

Rwamagana TSS is a school located in Rwamagana district. The trainer from this school 
given a task to make interior branding and trainees have finished using tools but the 
tools and equipment remain not cleaned and stored in their appropriate place. You are 
asked to clean them with appropriate cleaning method and store them in their 
appropriate storing place according to storing method. 

Check list for practical assessment 

Check list Score 

Yes No 

Indicator: cleaning workplace and storing tools and equipment 

Tools and equipment are well cleaned   

Cleaning materials are well used   

Cleaning methods are used   

Tools and equipment are well stored according to storing method   
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